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Introduction to this tutorial 

You can use the IBM® WebFacing Tool to create Web front ends to IBM eServer™ iSeries™applications that use DDS for their green-screen transactions. You choose a Web style for your green-screen application, generate a set of JSP and XML files that interact with the logic of your program, and then easily test your application in the WebSphere® test environment of the workbench. When you are ready to deploy your application, you can generate standard J2EE Web archive (WAR) and Enterprise archive (EAR) files that can be installed on a WebSphere Application Server. 
The IBM WebFacing Tool is ideal for applications that you want to deploy broadly over a corporate intranet or the Internet, where rapid deployment takes precedence over customizing the look and feel of each page. With the IBM WebFacing Tool you can continue to deliver your application as a 5250 application, and use the same ILE and non-ILE programs to deliver the application through the Web. Note that there are some restrictions, described in the IBM WebFacing Tool documentation, on which DDS keywords can be converted to generate sets of JSP and XML files. 

CODE Designer has been enhanced to work with the IBM WebFacing Tool. A new “Web Settings” section helps you specify how your DDS fields will be handled by a browser after they are converted using the IBM WebFacing Tool, without affecting their appearance on the green-screen. 

Tutorial purpose 
Before you begin, take a minute to read the learning objectives for the tutorial. 

Chapters 
Work on the chapters in sequence. The pictures in the chapters show similar tasks. Some of the names and icons may be different from the environment you will be working with when you complete the chapters. 

Prerequisites 
You should also learn about the prerequisite knowledge for the tutorial before beginning. This section describes the type of knowledge you need to already have to fully benefit from this tutorial. 
Learning objectives

In this tutorial, you will convert DDS screens in an existing 5250 order entry application to a Web browser user interface. While creating a browser user interface, you will learn how to use the IBM WebFacing Tool. You will also learn how to customize the output of the conversion process using the IBM WebFacing Tool and CODE Designer. You will learn how to run the WebFacing application in the WebSphere Test Environment that is part of WebSphere Development Studio Client. Finally, you will work through a series of advanced sections that will show how you can leverage and extend the IBM WebFacing Tool.
The tutorial is broken into chapters, each with their own specific learning objectives. You can choose to complete all chapters, or choose to complete only a few, depending on your learning goals. Each chapter is composed of several exercises. These exercises must be completed in order to successfully achieve the chapter's goals. 

“Verifying the latest fixes for the IBM WebFacing Tool” shows how to verify that you are working with the latest server, client tools, and environment for the IBM WebFacing Tool. 

“Reviewing the 5250 order entry application” helps you learn about the 5250 order entry application before you start and how to use the IBM WebFacing Tool to convert it. This allows you to become familiar with the 5250 screens and the behavior of the application. After the conversion you can then easily compare the 5250 and the Web user interface. 

“Creating the WebFacing project” explains that before you can use the IBM WebFacing Tool to reface your application you need to create a WebFacing project. You will also learn that this project is a complete Web project with the directory structure and files needed to conform to the Java™ 2 platform, Enterprise Edition (J2EE) standard, of a Web application. It also contains additional information unique to WebFacing like the source to be converted as well as runtime information. 

“Converting selected source members” helps you learn about the conversion option, how to select one or multiple files for conversion, and how to work with the conversion logs to check the results of the WebFacing conversion. 

“Running the WebFacing application” explains how to run the Web application in the WebSphere Test Environment. You also learn about the WebSphere Test Environment. You see the results of the conversion results and have the opportunity to try the converted interface like you did in “Reviewing the 5250 order entry application.”
“Changing the user interface” shows you how to change certain aspects of the user interface related to the conversion process. 

“Changing the style of the Web user interface” explains how to create a new style, change style settings, specify the new style to be used for the project, and refresh the project with the new style. 

“Command key rules and labels” explains how to add your own command key recognition rules to the WebFacing conversion properties. You will also learn how to add command key labels that have missing labels in the DDS source. 

“Working with more style properties” show you how to apply changes to windows, the look of push buttons, and subfiles. 

“Adding authentication” explains how to secure your application by forcing authentication before the application is called. 

“Enhancing index.jsp page” explains how to take the plain index.jsp page generated by the IBM WebFacing Tool and add color and some pictures to make the input page of the Web application more interesting. You will learn how to use the Page Designer tool and some other related Web tools. 

“Export/Import IBM WebFacing Tool projects in WebSphere Development Studio Client” is a step by step example on how to move your IBM WebFacing Tool into and out of WebSphere Development Studio Client for iSeries.
“Exporting to iSeries WebSphere Application Server Express 5.1” describes how to export files created by the IBM WebFacing Tool to a remote WebSphere Application Server, to publish and deploy your application as you would when your application is ready for production. 

“IBM WebFacing Tool Deployment Options” discusses the options for deploying, and IBM WebFacing Tool Application. It covers partial deployment, JSP precompile options, and configuring the pre-touch attributes.

“Creating a WebFacing Portlet project” is a simple example of creating an IBM WebFacing Tool portlet project in WebSphere Development Studio Client. As part of this section you will use the WebSphere Portal Test Environment in WebSphere Development Studio Client for iSeries to run the IBM WebFacing Tool Portlet without having to install WebSphere Portal Server on your iSeries.

“Enabling System Screen support” is a simple example of creating an IBM WebFacing Tool project with system screen support. This section also discusses what system screens are officially supported.
“Invoking a Java Application from a WebFaced Web page” shows how to incorporate Java applications into your WebFacing application to extend and enhance the functionality of your IBM WebFacing Tool application.

“Invoking an iSeries Program from a WebFaced Web page” explains how to incorporate other iSeries Programs into your IBM WebFacing Tool application using the Web Interaction Wizard to extend and enhance the functionality of your IBM WebFacing Tool application.
“Adding a pop-up calendar” incorporates publicly available Java™ Script code to create a pop-up calendar for a date field. The pop-up calendar then takes the date selected and places the information into the date field.
“Advanced Web Settings Example” is a series of advanced short examples that demonstrate the flexibility and power available in Web Settings.
“Configuring the WebFacing server” teaches you how to use the WebFacing server configuration Data Area to configure the WebFacing server for up to 16 interactive subsystems
Be sure to read the prerequisite knowledge for the tutorial before beginning. This section describes the type of knowledge you need to already have to fully benefit from this tutorial. 
Prerequisite knowledge

In order to complete this tutorial end-to-end, you should already have working knowledge of the following: 

· Basic Microsoft® Windows® operations such as working with the desktop and basic mouse operations such as opening folders and performing drag-and-drop operations 

· How Web applications work 

· How to use a browser to navigate the Internet 

It is also useful, but not necessary, for you to have basic knowledge of the following: 

· DDS 

· Servlets and JavaServer Pages (to understand the generated output of the IBM WebFacing Tool) 

If you do not have current knowledge of these technologies and concepts, you might be interested in learning more about these after you complete this tutorial. You can find additional information on these topics in the Help system that is part of WebSphere Development Studio Client for iSeries. There are also plenty of resources on the Internet at our product Web page: http://ibm.com/software/awdtools/wdt400  
In the next chapter, you use a 5250 emulation screen to start the sample Order Entry application. In this application you will be prompted with the first screen for a customer number. Through the use of help panels, you will select a customer from a list of valid customers, and then go through the steps of filling an order by specifying the quantity ordered. After all parts and quantities for this order have been decided you complete the order by pressing a specific command key. The application will then prompt you for a new customer number to handle the next order. 

When you are ready to begin, start with Reviewing the 5250 order entry application.
Verifying the latest fixes for the IBM WebFacing Tool

When starting a WebFacing project, it is very important to have the latest IBM WebFacing Tool fixes for both the Client and the Server. This example will show you how to ensure you are working with the latest version of the tool. If you do not have Internet connectivity you should review the steps but will be unable to complete the steps yourself. In order to accomplish these learning objectives, there are a few steps that are involved. 
· Exercise 0.1: Verify latest version of WebSphere Development Studio Client for iSeries (IBM WebFacing Tool Client)

· Exercise 0.2: Verify IBM WebFacing Tool client fixes

· Exercise 0.3: Verify IBM WebFacing Tool server PTFs

Length of time: 
This chapter will take approximately 10 minutes to complete.

Exercise 0.1 Check WebSphere Development Studio Client Version

To determine your WebSphere Development Studio Client version you must: 

1. Start WebSphere Development Studio Client for iSeries. This can be accomplished by clicking on: Start > All Programs > IBM WebSphere Studio > Development Studio Client Advanced Edition for iSeries

[image: image1.emf]


2. As WebSphere Development Studio Client for iSeries starts, its splash screen tells you what version of the tool you are running. 

[image: image2.emf]


Exercise 0.2 Verify IBM WebFacing Tool client fixes 

In this step, you will be updating WebSphere Development Studio Client with the latest fixes available for the version of the tool that you are running. 

Run Software Updates

To run Software Updates in WebSphere Development Studio Client: 

1. Ensure WebSphere Development Studio Client is running — WebSphere Development Studio Client should be running after you completed the previous step. If it is not running, start it.

2. Ensure that there is a perspective open in WebSphere Development Studio Client — For Software Updates to run in WebSphere Development Studio Client a perspective needs to be open. By default the Remote Systems Explorer perspective is open. If there is not a perspective available, open one by clicking on [image: image3.emf]

 and selecting the Remote Systems Explorer perspective.

3. Run New Updates by clicking on Help > Software Updates > New Updates. This will start a search for updates.
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4. WebSphere Development Studio Client for iSeries Software Updates may need to be run more than once to receive all updates. New Updates should be run until you receive a message stating that there are no new updates.
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Exercise 0.3 Verify IBM WebFacing Tool server PTFs

Making sure that you have the latest PTFs installed on your iSeries server is very important to avoid encountering errors in your IBM WebFacing Tool application. It is simple and fast to check IBM WebFacing Tool PTFs on your server.

Verify PTFs

To verify the PTFs on your iSeries server: 

1. A list of the latest IBM WebFacing Tool PTFs can be found at: ibm.com/support/docview.wss?rs=255&uid=swg27002213  
The PTFs are categorized based on what version of the operating system you are running. 
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2. Once you have the most current list of PTFs you can check your iSeries server to see if they are installed. This can be done using the DSPPTF (Display Program Temporary Fix) command.
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Recap

Congratulations! You have completed Verifying the latest fixes for the IBM WebFacing Tool. You should now understand how to: 

· Determine your version of WebSphere Development Studio Client for iSeries (IBM WebFacing Tool Client)

· Verify IBM WebFacing Tool client fixes

· Verify IBM WebFacing Tool server PTFs

Ensuring you are working with the most up-to-date version of the tools is very important in order to utilize functionality and avoid problems. As you have seen in this section it is easy and fast, so there is no excuse to be working without the latest fixes.

Reviewing the 5250 order entry application

In this chapter, you are going to explore the application by invoking it from a 5250 session and working with the applications green-screens and command keys. This will also test your user profile setup. If you can run this application directly without changing the job environment on the iSeries server, the WebFacing conversion and the WebFacing server will not have problems during the remaining exercises later. 

Note: If you have problems, make sure the library list for your job is setup correctly to include library WFLABXX at job start up. 

You will learn about the 5250 application, before you start to use the IBM WebFacing Tool to convert it. This will allow you to become familiar with the 5250 screens and the behavior of the application. After the conversion with the IBM WebFacing Tool you will then be able to compare the 5250 and the Web user interface. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 1.1: Starting the 5250 application 

· Exercise 1.2: Accessing the online help 

· Exercise 1.3: Selecting a customer 

· Exercise 1.4: Filling the order 

· Exercise 1.5: Completing the order 

The exercises in this chapter must be completed in order. Start with “Exercise 1.1: Starting the 5250 application” when you are ready to begin. 

Length of time: 
This chapter will take approximately five minutes to complete.
Exercise 1.1: Starting the 5250 application

You need a 5250 emulator on your workstation to start the order entry application. To start the 5250 application: 

1. Start a 5250 emulation session.
2. In the User ID field, type your User ID.
3. In the Password field, type your password.
4. On the command line of the 5250 screen, invoke the Order Entry Application: 
CALL ORDENTR 

The application starts and shows the first panel. This first screen prompts for a customer number. You have a choice of keying in the customer number directly or you can press command key F4 to display a list of existing customers. 

[image: image9.png]=21 ession A - [24 x 80]

actions_ Window_tielp

Tupe choices, press Enter.
Blchanas

AR — Order runber

FasPrompt  FE-Accapt Order

101 on psprint1ipd101




Exercise 1.2: Accessing the online help

Before you go ahead with the order entry process, try the help. This application uses User Interface Manager (UIM) help. You will also convert these UIM help panels with the IBM WebFacing Tool. To understand the results of the UIM help conversion, try the help in the 5250 environment and then later in the browser. 

1. Move the cursor to the Customer number field. 

2. Press command key F1. 

Panel group help displays for the customer number. 
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3. To see more help, move the cursor underneath the 1 in the help area and press the Enter key. 

Help for requesting a customer list displays. 
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4. Press command key F12 to return to the help for the Customer number field. 

5. To see help for the second choice, move the cursor underneath the 2 in the help area and press the Enter key. 

Now you see detailed help for specifying a valid customer number. 
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6. Press command key F12 to leave the help for the Customer number field. 

The main help panel in the Select customer - Help area shows. 

7. Press command key F2 to get to the extended help. 

Here you see the extended help for the Customer number field. 
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8. Press command key F12 to leave the extended help for the Customer number field. 

9. Press command key F12 again to leave the help for the Customer number field. 
Exercise 1.3: Selecting a customer

Now you have an understanding how the help panels in this application work and look. Next you need to identify the customer related order. You have the choice of specifying a valid customer number, or you can get a selection list of valid customers. Use the selection list because it shows a record format that uses the Window DDS keyword and so you can see how the IBM WebFacing Tool converts a DDS window. 

1. Press command key F4 to display the customer selection list. 

A list of customers displays. 
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2. In the Options field, type 1 to select a customer. 

3. Press the Enter key to proceed. 

This returns you to the initial panel now filled with detailed data for the selected customer. 
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You'll notice that an order number has been assigned as well. You are now ready to order some parts.
Exercise 1.4: Filling the order

The process of selecting parts is similar to the way you selected a customer in the previous exercise. You are able to key in the part number directly or select the part from a selection list. Next you want to work with the parts selection list. 

On the order entry panel: 

1. Press command key F4 to see a list of available parts. 

The Select Part panel opens. 
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2. In the Options field, type 1 next to a part that has lots of quantity left. 

Back on the order screen, the part appears in the order; on the top line of the parts list. 
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Next you order a certain quantity of this part. 

3. Change the Qty field to a value, for example 2. 

4. Press the Enter key to add the part and quantity ordered to the order. 

The detail order line for this part, with the quantity specified, is now part of this order. 
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Add more parts until your order is complete. 

5. Press command key F4 to see a list of available parts. 

6. Select a part from the parts list and press Enter. 

7. Specify the part quantity and press Enter.

Exercise 1.5: Completing the order

Now you are ready to accept the order. You use the Order Entry panel to complete the order: 

1. Press command key F6 to accept the order. 

The order is added to the database and the next order can be filled. You return to the starting screen of the application. 

You have worked with all panels in this application: 

· The start order entry panel 

· Several help panels 

· The customer list window 

· The full order entry panel 

· The parts list window 

You can add more orders, but if you understand how the user interface of this application works, stop adding orders. 

2. Press command key F3 to exit the application. 

You are now ready to put a brand new user interface onto this application.

Recap

Congratulations! You have completed Reviewing the 5250 order entry application. You should now understand how to: 

· Start the order entry application 

· Use the help panels in this application 

· Select a customer from the customer selection window 

· Select parts from the parts selection window 

· Order a certain quantity of parts for the order 

· Complete the order 

· Exit the application 

Before you can use the IBM WebFacing Tool to reface your application you need to create a WebFacing project in the WebSphere Development Studio Client workbench. You will identify the project information, like the DDS source member names to be converted using the IBM WebFacing Tool, and they will be stored in a workspace on your workstation. 
This next chapter guides you through the process of identifying the DDS and UIM Panel Group source members to be converted by the IBM WebFacing Tool. It also goes through specifying some of the runtime information you will need later when running the WebFacing application. Continue to “Creating the WebFacing project.”
Creating the WebFacing project

In this chapter, you will learn how to create a WebFacing project, something that you need before you can create a Web user interface for the Order Entry Application. You will then learn how to use this WebFacing project to facilitate the conversion of your DDS source and to test the generated output. 

A WebFacing project is a complete Web project with the directory structure and files needed to conform to the Java 2 platform, Enterprise Edition (J2EE) standard of a Web application. It also contains additional information unique to WebFacing, like the source to be converted. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 2.1: Starting WebSphere Development Studio Client workbench 

· Exercise 2.2: Opening the WebFacing perspective 

· Exercise 2.3: Starting the WebFacing Web Project wizard 

· Exercise 2.4: Selecting display file members to convert 

· Exercise 2.5: Specifying the CL command to launch the application 

· Exercise 2.6: Selecting a Web style 

· Exercise 2.7: Completing the WebFacing project information 

The exercises in this chapter must be completed in order. Start with Exercise 2.1: Starting WebSphere Development Studio Client workbench when you are ready to begin. 

Length of time: 
This chapter will take approximately 25 minutes to complete.
Exercise 2.1: Starting WebSphere Development Studio Client workbench

Now go ahead and start WebSphere Development Studio Client. To start WebSphere Development Studio Client: 

1. On the desktop task bar, click Start > All Programs > IBM WebSphere Studio > Development Studio Client for iSeries 5.1.2. 
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A dialog appears asking you for the workspace location, unless you used the WebSphere Development Studio Client before and selected not to show this dialog again. 

The workspace contains all the information about your WebSphere Development Studio projects. You can accept the default or store the work related to this tutorial in a separate workspace. You can always start with a new workspace later, if you don't want to mix these “exercise” WebFacing projects with your real work. 
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You may run into problems if your workspace path is too long. If you have a problem with WebFacing projects not running in the WebSphere Test Environment and you see an error in the console similar to: 



 6cb33777 SystemOut O Exception in generateFieldAttributes :



 java.io.FileNotFoundException: 



 ...



 ...



 ...



 (The system cannot find the path specified)

You have run into a limitation of the server to handle long directory names. If you use a workspace in a directory with a long path or choose long names for your projects, you may get this error when starting a server, or when testing files on a server. If you receive this error, you may take any of the following actions: 

Move your workspace to a location with a shorter path, for example C:/workspace. 

Rename your Enterprise Application project, or other projects, with a shorter name.

2. Replace the default directory structure with your hard drive root and change the name of the workspace directory to the name WFLABxx. 

3. Click OK. 

After a few moments of loading, the workbench opens, and the initial window of WebSphere Development Studio Client opens. 
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Note: 

If you did not reset the workspace, or you are working with the standard version of WebSphere Development Studio Client, your environment will differ slightly from the screen captures in this tutorial.
Exercise 2.2: Opening the WebFacing perspective

The WebSphere Development Studio Client shows the Remote System Explorer (RSE) perspective by default. This is the perspective that you would use to work with iSeries objects. It allows specifying connections to iSeries servers and provides the programmer with a similar interface to iSeries objects as the Program Development Manager (PDM) does in a green-screen environment. 

The IBM WebFacing Tool provides its own perspective since it needs to give its users access to unique views and tools targeted towards the WebFacing task. To create a WebFacing project you first need to open the WebFacing perspective. 

To open a WebFacing perspective: 
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1. Click Window > Open Perspective > WebFacing from the workbench menu. 

The workbench now shows the WebFacing perspective with the WebFacing Projects view open in the left pane of the workbench. 
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You are ready to start the WebFacing project wizard to create a WebFacing project.

Exercise 2.3: Starting the WebFacing Web Project wizard

To start the WebFacing Web Project wizard: 

1. In the WebFacing perspective, click File > New > WebFacing Web Project from the workbench menu. 
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This will start the WebFacing Web Project wizard. 

2. In the WebFacing Web Project wizard, you will be presented with the WebFacing Web Project page. 
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3. In the Project name field, type the project name wflabxx.
The Enterprise Archive (EAR project) File will be updated automatically. 

This will create a unique Application file for this WebFacing project. 

4. Click Next. 

5. The Select Display File Source Members to Convert page opens. 
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Exercise 2.4: Selecting display file members to convert

On this second page of the WebFacing project wizard you need to specify the name of the iSeries server that contains your display file DDS source, as well as which members of the source file you want to convert. Specifically, the IBM WebFacing Tool needs to know these names: 

· Server name 

· Library name 

· Source file name 

· Member name 

Note: You need to identify members for all record formats used in your application. If you miss one, and at runtime the record format gets requested, your end user will get a Page not found error. 

Since you are starting with a new workspace, you need to specify the iSeries server name to specify where the Data Description Source (DDS) is located.

Connecting to an iSeries server
To connect to an iSeries server: 

1. Click New beside the Connection list. 
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The Name personal profile page opens. 
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2. Accept the default profile name as this is your own private connection. 

3. Click Next. 

The Remote iSeries System Connection page opens. 
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4. In the Host name field, type the name of the host system, for example s400a. This should be the name of your iSeries server where you have the WebFacing runtime running (STRTCPSVR *WebFacing). 

Note: This is your iSeries server name; don't use the one shown unless your system is named s400a. 

The connection name will be filled automatically with the same value. 

5. Leave the Verify host name check box selected to verify that the host name or IP address exists. 

6. Click Finish. 

The connection is created and can be re-used by all tools in the workbench. 

The connection wizard also checks whether the iSeries host can be reached and if this test is successfully completed, you return to the Select Display File Source Members to Convert page. 

7. Check that your iSeries server is selected in the Connection list. 
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8. Make sure that *LIBL is selected in the Library list. 

9. Click Refresh DDS list. 
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A User ID and password dialog opens. 
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10. In the User ID field, type your User ID. Use the same User ID that you used when running the Order Entry application in “Reviewing the 5250 order entry application.” 

11. In the Password field, type your password. 

12. Select the Save User ID check box. 

13. Select the Save password check box. 

14. Click OK. 

A connection to the iSeries server gets established. The library list of your iSeries job is displayed under the Refresh DDS list button on the Select Display File Source Members to Convert page. 
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Selecting DDS members

To select DDS members to convert: 

1. Select the WFLABXX library from the list. 

2. Click the plus sign (+) beside the WFLABXX library to expand it. 
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3. Select the QDDSSRC source file from the expanded list. 

4. Expand QDDSSRC and select all members from the list. 

5. Click the [image: image35.png]


 push button in the middle of the page to copy the selected members over to the list of members to be converted at the right. 

Tip: To move all members in a source file you can select the source file icon itself and click the [image: image36.png]


 push button. This will add all members in a source file to the list of members to be converted. 

The IBM WebFacing Tool now knows which DDS members to convert for this project. The conversion hasn't been done but the information is stored for future use. 

Next you convert UIM source members.

Selecting UIM source members

To select UIM source members to convert: 

1. Click Next to proceed to the next page of the wizard. 

The Select UIM Source Members to Convert page opens. 
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Now you have to identify the panel group source containing the help information for the Order Entry application. 

2. Click Refresh UIM list push button. 

3. Expand library WFLABXX. 

4. Select the QPNLSRC source file from the expanded list of library. 

5. Click the [image: image38.png]


 push button in the middle of the page to copy all members over to the list of members to be converted at the right. There is actually only one panel group member ORDENTRPNL in this source file. 

6. Click Next to proceed to the next page of the wizard. 

Exercise 2.5: Specifying the CL command to launch the application

You will now provide the information that will allow the WebFacing Web Project wizard to create the initial index.jsp page to start the Order Entry application. Do you remember what you typed on the command line to start the Order Entry application in the 5250 emulation session during the first exercise in “Reviewing the 5250 order entry application”? In case you forgot, it was: CALL ORDENTR 

Why should you remember? The WebFacing run time needs to know the invocation command for your application in order to send this invocation command to the iSeries server to start your application from the browser. The page in the WebFacing Web Project wizard will allow you to specify the necessary CL command information and Sign-on information. 
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To specify the CL commands: 

1. In the CL command field, type: CALL ORDENTR 

2. In the Command Label field, type: Order Entry Application. 

Note: If you don't type anything into the Command Label field, the CL command input will be copied into this field. 

3. Leave the default value INV1 in the Invocation name field. 

4. Click the Sign-on with specified values radio button. 

This will automatically apply the User ID and password you used when you connected to your iSeries server in the previous dialog for selecting source members for invocation of this application. You will use this setup here for testing purposes to make it easier for you to start the Order Entry application without specifying the authentication information. Don't worry about security in your production environment, this can be easily changed later and you will see how to do this later in the tutorial. 

5. Click Add on the right side of the page. 

Note: Make sure the text and command you typed into the fields are actually shown in the CL Command table at the bottom of the page. 

6. Click Next at the bottom of the wizard page. The Choose a Web Style page opens.

Exercise 2.6: Selecting a Web style

Next you select a Web style for your converted screens. 

To select a Web style: 
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1. Select the gradient style from the list of available styles. 

2. Click Next. 

The Completing WebFacing Project page opens.

Exercise 2.7: Completing the WebFacing project information

On this page, you have the choice of creating the project and converting the source in one step or only creating the WebFacing project. 

For our example purposes, you will just create the WebFacing project. You don't need to convert the source right now. Conversion is part of the next chapter. 
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To complete the WebFacing project information: 

1. Select the No. I only want to create the project now radio button. 

2. Click Finish. 

The WebFacing project is created. The workbench opens in the WebFacing perspective with your new WebFacing project in the WebFacing Projects view. 
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Ignore the warnings that you see in the Tasks view. These warnings are fixed at runtime. 
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Notice that the WebFacing project icon indicates which J2EE level will be used for the project. 

If you expand the wflabxx project you'll notice several files and folders have been added to this WebFacing project: 

1. The information for display file source members to be converted 

2. The information for panel group source members to be converted 

3. The CL Command that will be used to start the Order Entry application 

4. The style to be used for the converted screens. 

When you expand the folders and files under your WebFacing project, you can see the information that is captured for this project. 
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3. Click each folder or file. Click the plus (+) sign beside each file or folder. 

Tip: If you later need to add source members to the WebFacing project, right-click the DDS or UIM help icon and click Add on the pop-up menu. This will launch the WebFacing Web Project wizard and display the correct dialog. 
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Recap

Congratulations! You have completed Creating the WebFacing project. You should now understand how to: 

· Start WebSphere Development Studio Client 

· Launch the WebFacing project wizard
· Complete the pages of this wizard in order to create a new WebFacing project called wflabxx 
· Add to this WebFacing project the following information: 

· Which DDS display file source members to use for the WebFacing conversion 

· Which UIM panel group source members to convert 

· The CL command which will be used to create the initial index.jsp page to start the Order Entry application 

· The Web style to be used for the resulting Web pages 

· Inspect the WebFacing project. Verify that all information entered in the WebFacing project wizard has been captured.
You have created a WebFacing project in WebSphere Development Studio Client, in this project you specified which display file source and panel group source to convert and which iSeries server these source members are located on. The IBM WebFacing Tool will use this information during the conversion process. You have to specify in this next chapter whether you want to convert all source members belonging to this project or selected ones only. 
A word regarding security: In case you are wondering as to why you don't have to logon to the iSeries server during conversion. Your User ID and password have been stored during the WebFacing project setup and will be re-used here. 
Continue to Converting selected source members.

Converting selected source members

In the previous chapter you specified the complete information the IBM WebFacing Tool needs to successfully convert your application; now you'll do the conversion itself. 

In this chapter, you will learn how the WebFacing conversion creates the JSP files for the browser User Interface description, XML files for record format layouts, and several other files needed for the Web application. You will learn how to select the convert option, start the conversion and work with the conversion logs to check the results of the WebFacing conversion. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 3.1: Selecting the project and source members 

· Exercise 3.2: Starting the WebFacing conversion 

· Exercise 3.3: Checking the conversion logs 

The exercises within each chapter must be completed in order. Start with Exercise 3.1: Selecting the project and source members when you are ready to begin. 

Length of time: 
This chapter will take approximately 10 minutes to complete.

Exercise 3.1: Selecting the project and source members

You will use WebSphere Development Studio Client to do the WebFacing conversion. If it is not up and running already, start it now. If it is still up and running on your workstation you are ready to go ahead. 

If the WebFacing perspective with your project is not visible, you need to open the WebFacing perspective.

Opening the WebFacing perspective

To open the WebFacing perspective: 

1. Check the taskbar of the workbench for the WebFacing perspective icon and if you find it, click on the icon to switch to the WebFacing perspective that is already open but not active at the moment. 
Tip: Avoid having too many instances of the same perspective open. It will improve performance of the workbench if you restrict yourself to one instance of a specific perspective being open. We have seen situations with 50 perspectives being open at the same time; this has caused severe performance impacts, so be careful. 
2. Here you see the icons on the taskbar of the workbench. The Remote System Explorer perspective is active. The workbench window title bar shows this. Four perspectives are open in the workbench. 

[image: image46.png]& Remote System Explorer - Welc

Fle Edt Navigate Search Project

48 Remote ystems

&@c::v(\)(-f





a. [image: image47.png]5]



 The WebFacing perspective 

b. [image: image48.png]


 The Remote System Explorer perspective 

c. [image: image49.png]


 The Java perspective 

d. [image: image50.png]


 The Web perspective 

3. To switch to the WebFacing perspective. Select its icon [image: image51.png]5]



 from the taskbar.
Tip: The icon [image: image52.png]


 on top of the taskbar allows you to open a new perspective. 

Next you start the conversion in the WebFacing perspective.

Selecting members to convert

To select members to convert: 

1. Select the WebFacing project you have been working on in the previous chapter, wflabxx. 

2. Expand this project by clicking the plus sign (+) beside its icon in the WebFacing Projects view. 
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You should see a DDS folder in the expanded view. 

If you don't see a DDS folder, you might be in the Navigator view and not in the WebFacing Projects view. 

3. Check that the view title bar is not WebFacing projects. 

4. Locate the WebFacing Projects tab at the bottom of the list view, and click it. 
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Now the WebFacing Projects view should be active and you should be able to find the DDS folder. 
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5. Expand the DDS folder, so that you can see all three of the members that you selected in the previous chapter. 

Next, you convert these members.

Exercise 3.2: Starting the WebFacing conversion

From here, you can select individual members to convert or a collection of members. Later in this tutorial when you change only one source member you will select a single member to be converted. Since you want to convert all members in the project, you can actually work with the WebFacing project icon to convert DDS and UIM panel group members. 

1. Right-click the wflabxx WebFacing project. 
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2. Click Convert on the pop-up menu. The conversion process starts. You will see a progress dialog, indicating what members are being converted. 
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Wait until the progress dialog disappears, indicating the WebFacing conversion has finished.

Exercise 3.3: Checking the conversion logs

Notice the conversion log in the right pane of the workbench. 

[image: image58.emf]


To check the conversion log: 

1. Click the Overview tab. 

2. Click the Reference Keywords tab. 

3. Click the DSPF Conversion Log tab. 

4. Click the UIM Help Conversion Log tab. 

As you click each tab, you will see more details about each log. 

You have now converted the DDS display file and panel group source. 

The DDS source and panel group source is now available in a form a browser understands. The first important step to move your application to the Web is done. Notice, the conversion itself was pretty easy, because you already did the hard part when you created the WebFacing project. Now that the project exists the IBM WebFacing Tool has all the information readily available which makes having to re-convert later, because of changes in the original source, not a big problem.
Recap

Congratulations! You have completed Converting selected source members. You should now understand how to: 

· Select the WebFacing project to convert 

· Select all DDS source members and all panel group source members that are part of the WebFacing project 

· Start the WebFacing conversion process 

· Analyze the conversion logs to ensure no errors have occurred during conversion 

You have used the IBM WebFacing Tool to convert the user interface of the Order Entry application and you now want to see the conversion results. The IBM WebFacing Tool created a complete Web application that can be run in an WebSphere Application Server. The WebSphere Application Server test environment and the Web project in the workbench are completely integrated and without publishing (copying) any of the files in the Web project they are known to the WebSphere Application Server test environment. 

The index.jsp file that has been created by the WebFacing conversion routine is part of this Web project. It will be used as the default page for this Web application. When the application is up and running you will go through the same scenarios as in Reviewing the 5250 order entry application when you went through the green-screen panels of the Order Entry application but now you are using the new WebFacing user interface. 

Next you will run your application with its new user interface. Continue to Running the WebFacing application.

Running the WebFacing application

You normally would now have to copy all the files of your Web project to a WebSphere Application Server and then run your application there. However, there is a WebSphere Application Server included with WebSphere Development Studio Client and it is called the WebSphere Test Environment. Using the WebSphere Test Environment makes the process of locally testing your WebFacing application easier than testing on a remote WebSphere Application Server. 

Later on for your production environment you would copy all files needed to your production application server and you will learn in Exporting to iSeries WebSphere Application Server Express 5.1 how to go through this process for the various versions of WebSphere Application Server. In your real application development environment, you would test thoroughly in the test environment; then export the WebFacing project files to a remote WebSphere Application Server for final testing, before moving the Web-enabled application to your production WebSphere Application Server environment. Exporting to iSeries WebSphere Application Server Express 5.1 shows you the steps required to deploy to a remote WebSphere Application Server environment. Until you are sure your WebFacing application is ready for public use, you can use the test environment on your workstation, which simplifies the testing of Web applications. 

In this chapter you will learn how to test your WebFacing application in the WebSphere Test Environment. You will learn how to specify in the WebFacing perspective that you want to run your project in the WebSphere Development Studio Client test environment. From the initial Web page, you will learn how to select the link created by the IBM WebFacing Tool to invoke the WebFacing Order Entry application. The ability to programmatically call a WebFaced application will also be discussed.
In order to accomplish these learning objects, there are several steps that are involved, including: 

· Exercise 4.1: Showing the index.jsp page 
· Exercise 4.2: Testing the WebFacing application

· Exercise 4.3: Testing the help support
· Exercise 4.4: By Pass Log-in Screen 

The exercises within each chapter must be completed in order. Start with Exercise 4.1: Showing the index.jsp page when you are ready to begin. 

Length of time: 
This chapter will take approximately 15 minutes to complete.

Exercise 4.1: Showing the index.jsp page

To show the index.jsp page: 

1. Right-click the wflabxx WebFacing Projects folder. 
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2. Click Run on server on the pop-up menu. 

A Server Selection dialog opens. 
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You can avoid having this dialog open every time you select run on server. 

3. Select Express Test Environment under WebSphere version 5.1. 

4. Select the Set server as project default (do not prompt) check box. 

5. Click Finish. 

The WebSphere Application Server test environment starts. After a few moments, the browser opens in the upper right view area of the workbench. Be patient; it takes time for the application server to start on your workstation. 

The minimum memory requirement for running the WebSphere Application Server test environment is 768 Mega Bytes according to the IBM announcement letter for WebSphere Development Studio Client Version 5. You can run this WebFacing project successfully on systems with 256 Mega Bytes. It will take more time for the application server to start if you are working on a workstation that has less than the required memory. The system speed will also have an impact on the application server start up time. Eventually you will see the index.jsp page that has been generated by the IBM WebFacing Tool opening in the workbench's built-in browser. 

Here you see the browser inside the workbench with the index.jsp page displayed. 
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Tip: To enlarge the browser window to the size of the workbench window, double-click the browser title bar. To get it back to its original size in the upper right hand workbench view area, double-click the enlarged browser window title bar. 

You have a choice of running WebSphere Application Server Version 4 or Version 5 in the workbench test environment. In this tutorial you will be using WebSphere Application Server Version 5.1 in the Test Environment and J2EE level 1.3. 

Note: Be aware if you use WebSphere Application Server Version 4 which only supports J2EE level 1.2, you need to setup your application server environment to enable UTF-8 support. This setup has to be performed for every application server that runs a WebFacing application. Instructions on how to setup the WebSphere Application Server
environment for UTF-8 are available in WebSphere Development Studio Client by clicking on Help > Help Contents > Deploying > iSeries WebFacing applications > Configuring UTF-8 support in WebSphere Application Server.
Exercise 4.2: Testing the WebFacing application

To run the Web application: 

1. In your browser pane, click the Launch link. 

After a few moments the first application page opens in the browser. 
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If you find the response time slow, keep in mind that the first time the JSP file is requested, it has to be compiled into a servlet. If you run the application a second time, you will see improved performance since the servlet already exists. This is normal application server behavior. 

Now you want you to go through the same steps as in Reviewing the 5250 order entry application to review the results of the WebFacing conversion. This will give you a sense of how the default conversion will change your original application. You will then have a chance to improve the conversion results. 

2. Click the Prompt button, or press command key F4 to open the selection list window. 
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3. Select a customer from the list (this is your converted subfile). 
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4. Press the Enter key. 

5. Click the Prompt button, or press command key F4 to display the parts selection list. 
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6. Select a part. 

7. Press the Enter key. 

The Parts Order Entry window opens. 
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8. Enter a quantity. 

9. Press the Enter key. 

10. Continue ordering one or two more parts. 

11. Press command key F6 to accept the order. 

The application works the same way as before in a 5250 environment; but the application now has a browser user interface.

Exercise 4.3: Testing the help support

To test the help: 

1. Press the F1 key. 

Another browser window opens with the help information. 
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2. Now try the links: 

· 1. Select 

· 2. Enter number 

· Extended help 

Your UIM based help panels are all available in the WebFacing application. 

3. Close the help browser window and press F3 to end the application.

Exercise 4.4: Bypass Log-in Screen

In certain circumstances, it may be desirable to bypass the WebFacing Login Screen. WebFacing applications can be invoked programmatically from other Web applications. This provides a way to integrate WebFacing generated user interfaces with existing Web applications.

WebFacing applications are launched from URLs. Typically, a URL is represented as a link that a user clicks to start the application. During a WebFacing conversion URLs are written to an index.jsp file and, after the application is deployed, these are the links users click to start the application. 

WebFacing URLs can also be constructed dynamically by other programs such as controller servlets. These URLs could be sent back to users as links to click on a Web page. But, more importantly, they can be used in the forward() and sendRedirect() methods in other Web applications. Using dynamically determined WebFacing URLs with the forward() and sendRedirect() methods mean that a program like a controller servlet can perform actions such as: determining the host to use, the WebFacing program to launch, what CL command to use for the WebFacing program, or other actions. After these actions are completed, the servlet can provide the appropriate WebFacing application, with its parameters already set, directly to a user.

Here is a simple example for a determining the CL command to use to launch a program:

URL constructed by a controller servlet: 

webfacing/services/invocation/WFInvocation.do?clcmd=call%20ordentr
In this example, ordentr is the name of a program to launch. The value ordentr could be determined by a servlet and assigned to a variable such as iseriesProgram. Your servlet could construct the URL string using the value determined for iseriesProgram and assign it to a variable newURL using a line like:

newURL = "webfacing/services/invocation/WFInvocation.do?clcmd=call " + iseriesProgram;

newURL could then be used as the forward or redirect URL for your forward() or sendRedirect() methods.

In this example, the complete URL used by the browser, if sent as a redirect, would look like:

http://<hostname>:<port>/<application>/webfacing/services/invocation/WFInvocation.do?clcmd=call%20ordentr

The example shows the full URL beginning with http://<hostname>:<port>/<application>/. 
The value for newURL is the string after this. That is, the string: webfacing/services/invocation/WFInvocation.do?clcmd=call%20ordentr. 
In an example like this, the first part of the URL: http://<hostname>:<port>/<application>/, represents the host, port, and context root for the application. If your controller servlet is in the same context root, it is not always required for the servlet to determine the entire URL. If necessary, though, you could code the servlet to construct a string for the fully qualified URL.

Note: The characters %20 in the URL represent a space character as encoded when sent to a browser. Space characters generally cannot be used explicitly in URLs. In the example where the URL string is being constructed and assigned to newURL, the space is present in the part of the string just after clcmd=call. The reason for the space in the string is that the example represents a CL command call ordentr. In the URL string that is being constructed, it is not necessary to add %20 directly. The server will add this encoding if necessary.

URL parameters that can be determined dynamically

clcmd — CL command to launch the program. 

host — Host name where the original 5250 application is located. 

User ID — User ID is used to log onto the application. Note: If a forward() method is used in your controller servlet, URL parameters are only sent within the application server tier (middle tier). Using sendRedirect() instead exposes URL parameters to the browser. In this way, sendRedirect() is less secure because information such as User IDs and passwords can be revealed in a browser's location field, or if a user views the properties for the page they are using. 

password — Password used to log onto the application. Note: If a forward() method is used in your controller servlet, URL parameters are only sent within the application server tier (middle tier). Using sendRedirect() instead exposes URL parameters to the browser. In this way, sendRedirect() is less secure because information such as User IDs and passwords can be revealed in a browser's location field, or if a user views the properties for the page they are using. 

inv — The invocation name for the WebFacing CL command used to launch the application. If values such as host, User ID and password are defined for a CL command, these values will override the general values specified for a project. To view the invocation name for a CL command, open the WebFacing perspective in the workbench, click the WebFacing Projects tab, expand your WebFacing project, expand the CL Commands folder, and click the label for the command. The value for the invocation name can be viewed in the Properties pane. If the Properties pane is not displayed in the WebFacing perspective, to open it, click Window > Show View > Properties.

Recap

Congratulations! You have completed Running the WebFacing application. You should now understand how to: 

· Setup the WebSphere Test Environment 

· Start the application in the WebSphere Test Environment
· Select a link on the index.jsp page to start the WebFacing application 

· Test the WebFacing application as you did in Reviewing the 5250 order entry application 

· Understand how to bypass the log-in screen of a WebFacing application by calling it directly

Next, you want to improve the user interface generated by the IBM WebFacing Tool. You want to improve the customer selection subfile. The Web user interface for selecting a record from this subfile does not work like a Web application. You have to key 1 into the options column to select a record; this is how the green-screen application works. You want a Web user interface where you can click on a link to select a customer. 

Then, you will be guided through the Web Setting capabilities in CODE Designer to make the necessary modifications. You will change the second column in the customer selection subfile, which contains the customer name, from a simple text output field to a link. When you click on this new customer name link, the correct information your program expects is sent. You might ask, what is the correct information? What is your program expecting? It is expecting a 1 in the subfile options field for the selected customer record. The program will receive the same information after you change the user interface. 

The WebFacing conversion will add logic to the user interface, so that the options field is filled with a 1 and the Enter key event is invoked when the link is pressed. You enhance the user interface and don't have to change the application, this sounds pretty impressive doesn't it. 
Continue to Changing the user interface.

Changing the user interface

To enhance the results of the IBM WebFacing Tool, you will use the feature Web Settings in the CODE Designer tool. CODE Designer is the GUI-based screen design tool for 5250 panels. It allows you to change certain aspects of the user interface related to the WebFacing conversion process. CODE Designer stores the Web Setting information as comment lines in the DDS source. When you convert the application using the IBM WebFacing Tool, these DDS source comment lines are picked up and applied to the new user interface. 

In this chapter, you will learn how to change the user interface of your WebFacing application with CODE Designer. In the WebFacing perspective you will learn how to select a DDS source member to work with; start CODE Designer to open this DDS member; work with Web Settings in CODE Designer to change the Web look, and then reconvert the DDS member. 

In order to accomplish these learning objects, there are several steps that are involved, including: 

· Exercise 5.1: Opening DDS display file source 

· Exercise 5.2: Applying Web Settings 

· Exercise 5.3: Testing the changed application 

The exercises within each chapter must be completed in order. Start with Exercise 5.1: Opening DDS display file source when you are ready to begin. 

Length of time: 
This chapter will take approximately 15 minutes to complete.

Exercise 5.1: Opening DDS display file source

Since you will use the WebFacing perspective to invoke CODE Designer you start this exercise using WebSphere Development Studio Client in the WebFacing perspective.

Starting WebSphere Development Studio Client and opening the Web perspective

To start WebSphere Development Studio Client and opening the Web perspective: 

1. Start WebSphere Development Studio Client and open the WebFacing perspective, if it is not up and running already. 

2. In the WebFacing perspective, make sure that you are in the WebFacing Projects view and not the Navigator view. 

3. Expand your project in the WebFacing Projects view by clicking on the plus sign (+) beside the WebFacing project icon.

Starting CODE Designer

To start CODE Designer: 

1. Expand the DDS folder. 

2. Right-click SLTCUSTD source member inside the DDS folder. 

3. Click Open With > CODE Designer on the pop-up menu. 

[image: image68.emf]


CODE Designer loads the DDS member. This takes a moment. 

The DDS member loaded in CODE Designer opens. 
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4. Select the SCREEN1 tab on the notebook. 

You should now see a similar dialog. 
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As you see, you are working with the green-screen image in CODE Designer. Do you recognize the screen? It is the customer selection list. This is the screen you will change, so it will appear more Web-like to the end user after the IBM WebFacing Tool has been run. 

5. Click the second column of the first row in the subfile (the Customer field). 
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Exercise 5.2: Applying Web Settings

Now work with the Notebook underneath the Design page. 

To apply Web Settings: 

1. Locate the Web Settings tab. 
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2. Click the Web Settings tab. 

The Web Settings page in the CODE Designer window opens. 
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3. On the Web Settings page, locate the list that shows the different Web Settings available for the Customer field. 

4. If not all Web Settings show, scroll down to the bottom of the list. 

5. Click Create hyperlink in the Web Settings list. 
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6. Select the Create hyperlink check box to the right of the list. 

7. Click the Action hyperlink radio button. 

8. Leave the Position cursor to field check box selected. 

9. From the list under the Position cursor to field select the &{OPT} value. 

10. In the Enter data list type 1. 

This indicates that you want a 1 to be entered in the Options field when the hyperlink is clicked. 

11. Select the Submit check box. 

12. Leave the Function key radio button selected. 

13. Select ENTER from the Function key list. 

Just to recap, you specified the following, when the application gets converted with the IBM WebFacing Tool; the customer name cells in the subfile will be generated so they appear as links in the browser window. At run time, when the link is clicked, a 1 will be placed in the Option field. Also, a submit request will be initiated to generate the equivalent of pressing the Enter key and the cursor will be positioned in the Option field for the selected row. 

You have accomplished the basic task, but the user interface now has an Option column that doesn't belong there since it is useless with the new link. Also the instructions on the page on how to select a customer are wrong. You want you to fix this with Web Settings as well before you test this new feature.

Hiding the option field

On the Design page, you now need to select the option field to indicate that you want to work with it. 
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To hide the option heading: 

1. Click the Opt column on the first record in the subfile to select it. 

2. On the Web Settings page select Visibility from the list. 

3. Select the Hide field radio button. 

Now this column in the subfile will be hidden.
Hiding the option heading for the option field

You need to hide the heading for the option field as well. The heading is not in the subfile record; it is located in the subfile control record. Therefore you need to give focus to a different record format in the design page. What does this mean? It looks like one record format but there are three record formats in this view. 

Let’s look at some of the CODE Designer features. Normally in the iSeries green-screen world, your screens are made up out of multiple record formats that at runtime get assembled by the RPG or COBOL program to present the real screen your end user sees. 

To make it easier for you at design time to get a feel of how the record formats you create would look like at runtime, CODE Designer has added the notion of a group. You can assemble several record formats in a group. This feature gives you the capability of mimicking what happens at runtime with your record formats. So a group resembles the runtime grouping of record formats for you at development time. In the sample you are working with, there are already assembled three record formats in group SCREEN1. The record formats are: 

· CUSTSFL 

· CUSTCTL 

· SLTCUST 

To get a list of record formats belonging to a group you can expand the list of record formats. 
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Only one record format in a group is active at a time. The record format name is listed in the top field of the record list. Also in the design page all parts in the active record format are shown highlighted but the inactive record format content is half-intensity. You see this effect very clearly above. Until now you have been working with the subfile record format CUSTSFL only, but now you need to clean up the subfile control record format CUSTCTL, so you need to make it the active record format, or another way to describe this would be to give it focus. 

Hiding the option heading

To hide the option heading Opt Customer: 

1. To shift focus to another record format, at the top of the Design page, click the arrow. 
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You will notice that the top area of the Design page is now highlighted, and the bottom one has only half-intensity. As mentioned before the highlighted area is the one you can work with. 

Next, you clean up the subfile control record format. 
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2. On the Design page, select the OPT Customer constant. 

3. On the Web Settings page, select Appearance and Text from the list. 

4. Select the Hide characters check box. 

5. Leave 1 in the From field. 

6. Type 3 in the To field. 

This hides the heading Opt. Now you need to remove the instructions on the panel that guide the user to put a 1 into the Option field to select a specific customer.
Hiding the select instruction

You don't have to give focus to a different record format since this constant is also located on the CUSTCTL subfile control record format. 

To hide the select instruction: 

1. Select the constant 1=Select in the Design page. 
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2. On the Web Settings page, select Visibility from the list. 

3. Click the Hide field radio button.

Changing the instruction (Type choice press Enter)

Now you need to add new instructions for the WebFacing page, so the end user knows to click the link to select a customer. 

Note: You can't just change the 5250 constant because you might still use this screen in a 5250 environment. You have to use Web Settings to apply this change to the Web user interface only. 

To change the instruction text: 

1. Select the instruction constant (Type choices press Enter) on the Design page. 
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2. On the Web Settings page, select Appearance and Text from the list. 

3. Select the Override constant text check box, and type the new text: Click on link to select in the field to the right of the check box. 

Now all Web Settings are in place and you can go ahead and save the DDS source and reconvert this DDS member. 

Closing CODE Designer and reconverting DDS

To close CODE Designer and re-convert the DDS member: 

1. Click the X button at the top right corner of CODE Designer. 
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2. When asked to do so, click Yes to save. You return to the WebFacing perspective in the WebSphere Development Studio Client workbench. 

3. Select your project wflabxx in the WebFacing Projects view. 

4. Expand the project by clicking on the plus sign (+) in front of its icon, if you can't see the DDS folder as part of the project. 

5. Expand the DDS folder, if it is not expanded already, to show all members in this folder. 
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6. Select the member SLTCUSTD that you just changed. 

7. Right-click SLTCUSTD member icon. 

8. Click Convert on the pop-up menu. 

Only this member will be converted. A conversion report opens after the conversion is finished. Now you test the new user interface. 

You return to the WebFacing perspective in the WebSphere Development Studio Client workbench.

Exercise 5.3: Testing the changed application

Let's see the new user interface in your application. 

To test the changed application: 

1. Right-click the wflabxx project icon in the WebFacing Projects view. 

2. Click Run on Server on the pop-up menu. 

3. Go to the browser pane and click the Launch link. 

You will see the first screen of your application. Nothing has changed there. 

4. Click the Prompt push button, or press command key F4. 
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The customer selection window appears and the customer fields are shown as links. Also notice the changed text and the non-visible option column. 

5. Select a customer from the list by clicking on the link. 

6. Go through the same steps as in Reviewing the 5250 order entry application to test the changed application.

Recap

Congratulations! You have completed Changing the user interface. You should now understand how to: 

· Access a DDS source member using CODE Designer 

· Change the Web user interface using Web Settings in CODE Designer 

· Convert the changed DDS 

· Test the changed application 

· Allow end user to change text size in the browser
Note: The green-screen user interface has not changed if the application is invoked as a green-screen application. It will look like the original user interface. The Web Settings apply only to the WebFacing user interface. 

Now, let’s say that when you tested the changed application, you found that you didn't like the way the IBM WebFacing Tool mapped some of the display attributes to colors and text styles available in the browser. You want to change the default WebFacing style rules that determine how certain 5250 parts are displayed in a browser to give the Web user interface a better look. Now you will make these changes. 
Continue to Changing the style of the Web user interface.

Changing the style of the Web user interface

In this chapter, you will learn how to change the user interface of your WebFacing application by using the WebFacing style properties dialog. The style changes are applied on a project level; so all pages in a project will be displayed with these changes applied. In this chapter you will change the text color and font for all highlighted fields. You will also locate the style file where these changes have been stored. 

In this chapter, you will learn how to change a style to tailor the Web interface to your needs. You will start the Style Properties dialog, create a new style, change style settings, specify the new style to be used for this project, and refresh the project with the new style. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 6.1: Changing the rules for highlighted fields 

· Exercise 6.2: Changing styles directly 

· Exercise 6.3: Allowing the end user to select text size

The exercises within each chapter must be completed in order. Start with Exercise 6.1: Changing the rules for highlighted fields when you are ready to begin. 

Length of time: 
This chapter will take approximately 10 minutes to complete.

Exercise 6.1: Changing the rules for highlighted fields

During this exercise you will use the Style Properties dialog in the IBM WebFacing Tool to tailor your Web user interface. You will change the rules for highlighted fields in the 5250 panels so they appear more visible in the Web user interface. The style for highlighted fields will be altered so at runtime the text font will be different and a larger font size will be applied. 

To change the rules for highlighted fields: 

1. Start the workbench of WebSphere Development Studio Client and open the WebFacing perspective, if it is not up and running already. 
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2. Right-click the wflabxx project. 

3. Click Properties on the pop-up menu. 

The WebFacing project properties dialog opens. 
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4. Under Style in the left pane of the Properties for wflabxx project, click DDS Field Display Attributes. 

In the right pane of the Properties for wflabxx, the DDS Field Display Attributes pane opens. 
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5. Click the push button to the right of the High intensity list. 

The Font dialog opens. 
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6. Under the Font list, select Comic Sans MS. 

7. Under the Font style list, select Bold. 

8. Under Size, select 16. 

Note: Don't try to change the color in this dialog, the color setting doesn't work, later in this chapter you will see how to change the color. 

This changes the font size and appearance for parts that have the high intensity attribute active. 

9. Click OK on the Font dialog. 

10. On the Properties page, click OK.

Checking the new style

Let's check the new style in your application. 

To check the new style: 

1. Right-click the project icon in the WebFacing Projects list. 

2. Click Run on Server on the pop-up menu. 

3. Go to the browser pane and click the Order Entry link. 

You will see the first screen of your application. 

Note: See the different font and font size of some of the text; these are the highlighted areas of your 5250 screen. 

4. Prompt for the customer. 

The customer selection screen has highlighted text and this text should show in font Comic Sans MS and size 16. 
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Note: If the text is still showing the old fonts, most likely the browser has cached the page and you need to close the browser window, and restart the application. This will bring up a new instance of the browser without cached content. 

5. The Font dialog has a bug that makes it impossible to change the Font colors directly. Next you will learn how to directly change WebFacing style classes.

Exercise 6.2: Changing styles directly

Instead of working with properties in the WebFacing project, you can also change the styles being applied directly in the Cascading Style Sheet (.css) file. In this exercise, you see where this file is located in the WebFacing Project structure and how to find your way around in this file. 

Modify the Cascading Style Sheet

To locate the Cascading Style Sheet file: 

1. Click the Navigator tab to switch to the Navigator view. 
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2. Locate the apparea.css file in the WebFacing project. 
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It is located in the following directory hierarchy: wflabxx\WebContent\webfacing\styles\apparea\ 

3. Double-click the apparea.css file icon in the Navigator view, to open an editor for this file. 

Next you change the “WebFacing highlighted” style class. 

The editor dialog will open and show the style source. 

4. Scroll down the source file until you reach the .wf-hi class. 
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You'll notice your changes from the previous exercise are applied here. The IBM WebFacing Tool has created style sheet classes for the different 5250 parts and attribute combinations and stored them here. Each of the lines starting with a dot contains a style class name. The statements inside the curly brackets after the style class name describe the attributes of the class itself. For this WebFacing .css file, the name of the classes are self describing. For example: .wf_hi defines how a part that has the highlighted attribute active gets displayed in the browser, .wf_cs describes the column separator, etc. You can go in and change the display characteristics for any of the 5250 attributes. 

Next you change the color attribute of the highlighted class. 

5. Position the cursor at the end of the last line of the .wf_hi class, before the ending curly (}) bracket. 

6. Press the Enter key to insert a line. 

7. Enter the color attribute you want to use, for example: color: red; 
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Note: Don't forget the semicolon to delimit the line. 

8. Save the change by clicking the Save icon in the workbench. 
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For version 5 users, there is a feature available in the Style sheet editor that allows you to look at the changes you have made to a class directly in the editor without actually invoking the page and showing in a browser. 

9. Look at the left beside the Style sheet editor. 
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To see the changed user interface, run the application again.

To test the changed WebFacing application: 

1. Click the X in the Window bar of any editors or views still open at the right upper hand side of the workbench to close them all. 

Now let's check the new style attribute in your application. 

2. Right-click the project icon in the WebFacing Projects view or Navigator view in the WebFacing perspective. 

3. Select Run on Server on the pop-up menu. 

4. Go to the browser pane and click the Order Entry link. 

You will see the first screen of your application. Notice the different color of the text in the highlighted areas of your Web page. Prompt for the customer. The customer selection screen will show the same changed attributes; remember style changes are applied to all pages as shown. 
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Note: If the text is still showing the old colors, most likely the browser has cached the page and you need to close the browser window, and restart the application. This will open a new instance of the browser without cached content. 

You might not have noticed it before, but there is still a command key description at the bottom of the Customer Selection list window. 

You might have guessed it; you will fix this in the next chapter.

Exercise 6.3: Allowing the end user to select text size

For some applications, it may be necessary to allow the user to adjust the screen resolution at runtime. Internet Explorer has the capability for users to change the text size in the View | Text Size menu.  

The IBM WebFacing Tool by default configures font settings in the appeara.css style sheet to be a 9 point font. When these values are set, the Internet Explorer View | Text Size menu is disabled. This example will show you how to enable Text Size for an IBM WebFacing Tool application.

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Verify the IBM WebFacing Tool default configuration 

· Modify apparea.css to allow use of Text Size in Internet Explorer

· Test changes made to your IBM WebFacing Tool application.

Verify the IBM WebFacing Tool default configuration
To verify the default IBM WebFacing Tool behavior:

1. Run your IBM WebFacing Tool application using Run on Server in WebSphere Development Studio Client. This is done by right clicking on your IBM WebFacing Tool project and selecting “Run on Server.”

2. Copy the URL from the test environment into a new Internet Explorer window. 
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Click on the Launch button. 

3. Try to change the text size by clicking on View > Text Size. Notice that changing to Largest or Smallest has no effect on the text displayed in the window. For many applications, this may be acceptable. For others with very busy screens or for visually challenged needs, this may not be acceptable.  
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Modify apparea.css
1. [image: image395.emf]

To allow the end user to adjust font sizes using Internet Explorer capabilities, switch to the Web Perspective by clicking on the [image: image98.emf]

 icon and selecting the Web perspective.
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2. Open the apparea.css file in the WebContent | Styles | apparea directory by double clicking the file.                                
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3. Notice the font-size property for both .wf_font and .wf_field entries. Removing the font-size property from each of these entries will allow the user at run time to control the text size of the WebFaced application. 
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4. Remove the 9pt font-size values from the .wf_font, .wf_field, and .trstyle properties. Save the apparea.css file and restart the Test Environment. 
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Test changes made to apparea.css
1. If you have the IBM WebFacing Tool application in a browser, close it. Restart the WebSphere Test Environment by clicking on the Servers tab located at the bottom of the WebSphere Development Studio Client window. Right-click on your WebSphere Application Server and select Restart. 
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2. Test the application by changing the Text Size in Internet Explorer to “Largest.” The results should be similar to below. 

[image: image104.emf]

 

Recap
Congratulations! You have completed Changing the style of the Web user interface. You should now understand how to: 

· Change the style for highlighted fields using the WebFacing properties dialog 

· Apply a new font style and a larger font size
· Test these changes and make sure they are applied to all screens. (You found that the changes were applied without a re-conversion of the DDS source. Style changes were directly applied at runtime and didn't require re-conversion.) 

· Edit the Cascading Style Sheet file directly with the Style sheet editor, to change the color attribute of the highlighted style class. 

· Save your changes and test the application to make sure these changes would appear on the application screens. 

In the sample Order Entry application, the Customer Selection list window doesn't follow the CUA® rules for command key descriptions. The IBM WebFacing Tool will by default not recognize these command key descriptions and will not delete them. The Order Entry main screen has a command key enabled that has no description associated with it. The IBM WebFacing Tool by default can't handle this situation and puts a default string in the push button label representing this command key. Next you learn how to enable the IBM WebFacing Tool to deal with these common green-screen environments. 
Continue to Adding command key rules and labels.

Adding Command key rules and labels

Most of the command key descriptions placed at the bottom of the original panels in the sample Order Entry Application have been removed from the WebFacing user interface. The removal happens automatically if the command key descriptions follow the Common User interface Access (CUA) rules (for example, F3=Exit). If they don't follow these rules you can supply the IBM WebFacing Tool with the command key description rules you use in your user interface, and the IBM WebFacing Tool will apply these rules to recognize your specific command key descriptions. One of the record formats in the sample application contains a command key description that doesn't follow the CUA rules. 

In this chapter, you will use the WebFacing conversion properties dialogs to add your own command key description rule. Also in your user interface you might have enabled command keys without describing them in the user interface because they are only used for specific functions and your end user knows how they work. For example, command key three for ending an application or command key 12 for canceling a task are well known to be enabled for these tasks. So your user interface might not list them explicitly at the bottom of the panel. The problem with this kind of user interface design is the IBM WebFacing Tool doesn't have a string it can put in the label of the push buttons on the Web page. It will just put for example CF12 for an active command key 12 in the push button label. However, there is an alterative. The IBM WebFacing Tool allows you to specify labels for these common command keys so it can label the command key push buttons correctly. You just have to tell the IBM WebFacing Tool in its conversion properties what the label is. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 7.1: Adding a new command key description pattern 

· Exercise 7.2: Adding command key button labels 

The exercises in this chapter must be completed in order. Start with Exercise 7.1: Adding a new command key description pattern when you are ready to begin. 

Length of time: 
This chapter will take approximately 10 minutes to complete.

Exercise 7.1: Adding a new command key description pattern

The prefix for the command key description in the SLTCUST record format is Fkey=. 
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This doesn't follow the CUA rules normally used in iSeries user interfaces, so the WebFacing conversion does not recognize this pattern and does not hide it. You have to add this prefix pattern to the IBM WebFacing Tool conversion rules in the WebFacing Properties dialog. 

To add a new command key description pattern to WebFacing conversion rules: 

1. In the WebFacing Projects view, right-click your WebFacing project wflabxx. 
2. Click Properties on the pop-up menu. 
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The Properties for wflabxx dialog opens. 
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3. In the left pane of the Properties for wflabxx, under Conversion, select Command Key Recognition Patterns. 

The right pane will switch to Command Key Recognition Patterns. 
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4. In the Prefix list, type Fkey 

5. In the Separator list, leave = 

6. Click Add to the right of these two lists. 

The additional rule is now part of this style. 

7. Click OK. 

Next, you will test this feature by converting the DDS member and running the application.

Reconverting DDS members

Since these are conversion properties, you are changing and not style properties as in the previous chapter, you will need to reconvert all members that contain command key descriptions with this pattern. In the sample Order Entry application, this is only member SLTCUSTD. 

To reconvert DDS members: 

1. In the workbench in the WebFacing Project view, expand the wflabxx project, if not already expanded. 

2. Expand the DDS folder, if not already expanded. 

3. Right-click the SLTCUSTD member icon. 

4. Click Convert on the pop-up menu. 

After the conversion, take a look at the change.

Testing the applied new rule

Let's see how the new rule is applied to your WebFacing application. 

To test the applied new rule: 

1. Right-click the project wflabxx in the WebFacing Projects view. 

2. Click Run on Server on the pop-up menu. 

3. Go to the browser pane and click the Order Entry link. 

You will see the first screen of the sample application. 

4. Click Prompt or press F4. 

The Customer Selection list window opens. 
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Note: Notice that the command key text Fkey12=Cancel is gone from the bottom of the window. 

5. Select a customer or cancel by pressing F12 to return to the Order Entry Application window. 

Now that you know how to change the command key recognition patterns in the IBM WebFacing Tool, you can add text to frequently used command keys that don't have a text description in the DDS source. 
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Back on the Order Entry panel, you can see that the push button for F12 does not have a description. Its label shows F12. You will learn how to fix the label in the next exercise.

Exercise 7.2: Adding command key button labels

The IBM WebFacing Tool allows you to specify command key descriptions for command keys that are commonly used in your application but not described in your DDS source and on your screens. This way the push button labels on the Web pages can automatically be changed during conversion to the correct text. You will add the description Cancel to the WebFacing conversion properties so the push button will get created to show a Cancel label instead of F12. 

To add command key button labels: 

1. Right-click your WebFacing project wflabxx. 
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2. Click Properties on the pop-up menu. 

The Properties for wflabxx dialog opens. 

3. In the left pane of this dialog, under Conversion select Command Key Button Labels. 

In the right pane of this dialog, the Command Key Button Labels opens. 

[image: image112.png]4 Properties for wilabxx

Er Conversion Command Key Button Labels
Command Key Recognition
Command Key Button Labe  This page allows you to modfy the style of allcommand key buttons displayed in your WebFacing

Edit Code Options. applcaton.
MNUDDS Options:
JMLRecord Metadsta s thi page for command key text that il ot be identFied by the recogniton patterns on the previous
£ Run Time page. Selectthe key and the button lsbelyou want to use, and add i to the table below.
) Project

ey st

505 o s G o —
Command key Fi2 Button label; ] Cancel ~

U Objct Mapsings 8 ST (e ) ),

b

Command Key Actions
System screens

EES Dekte
DDS Field Color
DDS Field Dislay Attribute iave Ll
iindow
Subfie ii2v2 D2,

Commandkeys

I the keyword fo the DDS command key has a text parameter, that parameter will be used in place of
the button label specfied an this page. IF no abel s Found ar specfied in this wizard, in CODE Designer,
or inthe keyward parameters, "ebiacing wil use the keyword selF 25 the button abel, or example,
CFOS or CAD3





4. Under the Command key list, select F12. 

5. Under the Button label list, select Cancel. 

6. Click Add to the right of these two lists. 

The additional label is now part of the WebFacing conversion properties for this WebFacing project. 

7. Click OK at the bottom of the properties dialog. 

Next, back in the WebSphere Development Studio Client workbench, convert the changed application.

Reconverting DDS members

To convert the application in the workbench: 

1. Expand the wflabxx project, if not already expanded. 

2. Expand the DDS folder, if not already expanded. 

3. Right-click the ORDENTD member icon. 

4. Click Convert on the pop-up menu. 

After the conversion, take a look at the change.
Testing the new label

Let's see the new label for the F12 push button in your WebFacing application. 

To test the new label: 

1. Right-click wflabxx project in the WebFacing Projects view. 

2. Click Run on Server on the pop-up menu. 
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3. Go to the browser pane and click the Order Entry link. 

4. Check that the Cancel push button on the first page now shows the correct label as shown. 

5. If the push button still has the old text, restart the Application server. 

6. Click the Servers tab at the bottom view in the workbench. 

7. Right-click the server icon. 
8. Click Restart on the pop-up menu. 
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9. Run the application again.

Exercise 7.3: Remove unwanted buttons

The IBM WebFacing Tool may generate unwanted buttons that developers may not want to display in the WebFaced application. This section will discuss how to remove unwanted buttons.

Remove unwanted buttons

The IBM WebFacing Tool may generate unwanted buttons that users do not want displayed on their Web pages. The “Help” Button as shown in the partial screen display below may be one of those button types.

[image: image115.emf]


To remove the help button, the CmdKeys.jsp file will need to be edited. An easy way to understand how CmdKeys.jsp works is to run the application in debug mode. Single stepping through the code will show you how all pages are built.   

To remove the HELP button you must: 

1. For this exercise, we will remove the default help button displayed on every Web page. First change to the Web Perspective by clicking on Window > Open Perspective > Web. If Web is not on the list of perspective, click on “Other…” and select the Web perspective. 

[image: image116.emf]


2. Open the CmdKeys.jsp file located in the chrome directory of your application by double clicking the file. Once CmdKeys.jsp is open in the editor click on the Source tab located at the bottom of the window. 

[image: image117.emf]


3. With CmdKeys.jsp open in an editor, look for the code in this file that looks like

        // If the key name is to be shown change it from "label" ot
        // "Fnn=label" so that the function key name is obvious  


        if ( (true == wfcmdkeys.isKeyNameShown()) && (false == keyName.equalsIgnoreCase(label)) )
        {
          label = fkey.transformFKeyName(keyName) + "=" + label;
        }



// should the keys have fly-over title


String titleString = "";


if (true == wfcmdkeys.isFlyOverShown()) {



titleString = " title=\"" + keyName + "\"";


}
         /*
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          *  At this point the key is fully resolved. You could
          *  place code here to skip over the the issuing of the
          *  key or modify or replace the key dynamically before
          *  emitting the key's html to the browser.
          */
        if (true == completeOverride)
        {
          %><td id="<%= idn%>" class="buttonup" width="<%=bWidth%>" height="<%=bHeight%>" <%=titleString%> onmouseover="<%=wfcmdkeys.getJsVersionedPrefix()%>bo_ibm(this);" onmouseout="<%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(this, 'buttonup');" onClick="<%=wfcmdkeys.getJsVersionedPrefix()%>bd_ibm(this);<%= ovrideClick %>"><%= fkey.transformFKeyName(label) %><script language='JavaScript'><%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(<%=idn%>);</script></td><%
        }
        else
        {
          %><td id="<%= idn%>" class="buttonup" width="<%=bWidth%>" height="<%=bHeight%>" <%=titleString%> onmouseover="<%=wfcmdkeys.getJsVersionedPrefix()%>bo_ibm(this);" onmouseout="<%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(this, 'buttonup');" onClick="<%=wfcmdkeys.getJsVersionedPrefix()%>bd_ibm(this);<%= ovrideClick %><%=wfcmdkeys.getJsVersionedPrefix()%>validateAndSubmit('<%= keyName %>','<%=wfcmdkeys.getUniqueId()%>');"><%= fkey.transformFKeyName(label) %><script language='JavaScript'><%=wfcmdkeys.getJsVersionedPrefix()%>regCmdKey('<%= idn%>', '<%= keyName %>', '<%= ovrideURI %>','<%= ovrideFrame %>','<%=wfcmdkeys.getUniqueId()%>');</script></td><%
        }
        col++;
      }
    }
  }

}
This code is what is responsible for displaying the keys on each page. A very useful way to determine what the code is doing is to set a breakpoint on the “if” statement and run the application in debug mode watching the value of label in the debug window.

4. To suppress the “HELP” key from being displayed, one potential way would be to check the value of the label, and not write the code or increment the col value if label contains the value “HELP”. The code to do this would look as follows. NOTE: You will only be adding two lines of code and a comment. The three lines are as follows. The first two need to be added before the comment // should the keys have fly-over title and the “}” needs to be added at the end of the block of code. The code you need to add is in a larger font in bold. Save your changes.
//If HELP button, remove
if(label.equals("HELP") == false){


}

        // If the key name is to be shown change it from "label" ot
        // "Fnn=label" so that the function key name is obvious  


        if ( (true == wfcmdkeys.isKeyNameShown()) && (false == keyName.equalsIgnoreCase(label)) )
        {
          label = fkey.transformFKeyName(keyName) + "=" + label;
        }



//If HELP button, remove


if(label.equals("HELP") == false){


// should the keys have fly-over title


String titleString = "";


if (true == wfcmdkeys.isFlyOverShown()) {



titleString = " title=\"" + keyName + "\"";


}
         /*
          *  At this point the key is fully resolved. You could
          *  place code here to skip over the issuing of the
          *  key or modify or replace the key dynamically before
          *  emitting the key's html to the browser.
          */
        if (true == completeOverride)
        {
          %><td id="<%= idn%>" class="buttonup" width="<%=bWidth%>" height="<%=bHeight%>" <%=titleString%> onmouseover="<%=wfcmdkeys.getJsVersionedPrefix()%>bo_ibm(this);" onmouseout="<%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(this, 'buttonup');" onClick="<%=wfcmdkeys.getJsVersionedPrefix()%>bd_ibm(this);<%= ovrideClick %>"><%= fkey.transformFKeyName(label) %><script language='JavaScript'><%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(<%=idn%>);</script></td><%
        }
        else
        {
          %><td id="<%= idn%>" class="buttonup" width="<%=bWidth%>" height="<%=bHeight%>" <%=titleString%> onmouseover="<%=wfcmdkeys.getJsVersionedPrefix()%>bo_ibm(this);" onmouseout="<%=wfcmdkeys.getJsVersionedPrefix()%>bu_ibm(this, 'buttonup');" onClick="<%=wfcmdkeys.getJsVersionedPrefix()%>bd_ibm(this);<%= ovrideClick %><%=wfcmdkeys.getJsVersionedPrefix()%>validateAndSubmit('<%= keyName %>','<%=wfcmdkeys.getUniqueId()%>');"><%= fkey.transformFKeyName(label) %><script language='JavaScript'><%=wfcmdkeys.getJsVersionedPrefix()%>regCmdKey('<%= idn%>', '<%= keyName %>', '<%= ovrideURI %>','<%= ovrideFrame %>','<%=wfcmdkeys.getUniqueId()%>');</script></td><%
        }
        col++;
      }
    }
  }
  }
5. Run the Application and the “Help” key should no longer be displayed. 
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Exercise 7.4: Modify the “Enter” key text
Some developers require the ability to change the Enter key text. This is quite easy to do for a whole project by making a simple change in the rtmessage.properties file. It is very important you edit the correct file because one is the source for the other. The rtmessage.properties file contains a lot of useful values such as password setting, message text, and many other values.
Change the “Enter” key text

To change the “Enter” key text you must: 

1. Open the rtmessage.properties file using the Navigator view in the WebFacing perspective. The file is located under your project: JavaSource>com>ibm>as400ad>webfacing>runtime>rtmessage.properties. Double click the file to open it in the editor.
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2. Look for the entry highlighted in the image below. 

[image: image120.emf]


3. Changing the text of the enter key is as simple as typing in a new value on the right hand side of the Enter=Enter statement. For the example change Enter=Enter to Enter=Ok. Notice also the other values in the file such as Exit. Save you changes. 
[image: image121.emf]


4. Once you have completed and saved your changes restart the test environment by clicking on the server tab, selecting your server, right clicking and selecting restart server. 

[image: image122.emf]


5. Once the Test Environment has restarted, switch back to the WebFacing Projects WebFacing perspective and test your application. Enter should now be replaced with Ok. 

[image: image123.emf]


Exercise 7.5: How to change the field exit key

By default, the IBM WebFacing Tool uses CTRL as the field exit key. Some customers might wish to use other keys as field exit keys. For example, a customer using the numeric key pad may have an application in which the + key will function as a field exit key.

Note: This example uses the numeric keypad located on most full size keyboards. If you are using a laptop that is equipped with an integrated keypad you should enable it, usually done by just turning on NumLock.
Verify Field Exit Key

To modify the Verify the Field Exit Key: 

1. Verify that CTRL is the default exit key by running the Order Entry application. In the Select Part Subfile press the CTRL key. Notice that the Opt entry field will go to the next field when the CTRL key is pressed.  

[image: image124.emf]


To redefine the field exit key:

1. Field Exit Keys can be redefined in the projects web.xml file. Switch to the Web Perspective and open the web.xml file by double clicking on it in the WebContent/WEB-INF directory. Once it is open switch to the source view by clicking on the source tab at the bottom of the window. Search for the WFFieldExitKeyCode parameter as shown below. 
 [image: image125.emf]


2. To change the exit code, we will substitute CTRL with the numeric key code for the + sign. The numeric value for the + sign is 107. Other key code values can be found by searching on Google for “key codes in Internet Explorer.” One of the Web sites is: www.parkenet.com/apl/KeyCodes.htm
Modify the web.xml file changing the value of Ctrl to 107. 

    <context-param>

         <param-name>WFFieldExitKeyCode</param-name>

         <param-value>107</param-value>

         <description>Field exit key code</description>

     </context-param>

3. Save the changes to web.xml. Restart your Test Environment and test your WebFacing project. (If you do not remember how to restart your test server you can review it in 7.4 step number 4.) It is necessary to restart the server because changes have been made to the web.xml file which is read once at server startup.

4. When the server has restarted, test the changes by running the WFLabxx application. Notice that the CTRL key no longer operates as the field exit key, but that now pressing the + key will operate as the field exit key. 

Recap

Congratulations! You have completed Adding command key rules and labels. You should now understand how to: 

· Start the WebFacing Project Properties dialog 

· Use the command key recognition properties page to change the Fkey12 command key recognition pattern for the command key label on the Customer Selection list window 

· Use the command key button labels properties page to change the undefined F12 command key label 

· Reconvert the application and then run the application and check the changes
· Remove unwanted buttons

· Change the text for buttons

· Select which key represents the field exit key 

Now you have a Web user interface where the green-screen look doesn't show through as much as after the first WebFacing conversion you did in Converting selected source members. However, you may still want to add some more refinements to the appearance of your Web pages. 
Continue to Working with more style properties.
Working with more style properties

In this chapter, you will learn how to change the user interface further, using style properties. You will learn to work with the IBM WebFacing Tool style properties and check the changes by refreshing the style and running the application. 

Since a style is used on a project level, all Web pages in your project will contain the changes you apply to a particular style. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 8.1: Starting the WebFacing properties style dialog 

· Exercise 8.2: Changing the appearance of the subfile 

· Exercise 8.3: Customizing the appearance of command keys 

· Exercise 8.4: Checking the new style 

The exercises in this chapter must be completed in order. Start with Exercise 8.1: Starting the WebFacing properties style dialog when you are ready to begin. 

Length of time: 
This chapter will take approximately 10 minutes to complete.
Exercise 8.1: Starting the WebFacing properties style dialog

First, you will use the WebFacing Style properties dialog to tailor your Web user interface. You will apply changes to the window layout of your screens, the subfile appearance will be changed, and you will enhance the command key push button looks. 

To start the WebFacing properties dialog: 

1. Start WebSphere Development Studio Client and open the WebFacing perspective, if it is not up and running already. 

2. In the WebFacing project view, select the wflabxx project. 

3. Right-click the wflabxx project, and click Properties on the pop-up menu. 

The Properties dialog opens. 
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4. Under Style in the left pane of the Properties dialog, select Window. 

The right pane of the Properties dialog shows the Window properties. 
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5. Select Title from the Windows areas list. 

6. Under Foreground click the [image: image128.png]


 push button to the right of the Color list. 

7. On the Color Chooser dialog, click Red. 

8. Then click OK in the Color Chooser dialog. 

The Window Properties page reappears. 

9. Click the [image: image129.png]


 push button to the right of the Font list. 

10. Select font Comic Sans MS, size 16. 

11. Click OK on the Font dialog. 

12. Under Background, click the [image: image130.png]


 push button to the right of the Color list. 

13. On the Color Chooser dialog, click Green. 

14. Click OK on the Color Chooser dialog. 

The Windows properties dialog reappears. 

15. Select Body in the Windows areas list at the top of the page. 
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16. In the Border color list at the bottom of the page, click the [image: image132.png]


 push button to the right of the Border color list. 

The Color Chooser dialog opens. 

17. Select Blue. 

18. Click OK in the Color Chooser dialog.
Exercise 8.2: Changing the appearance of the subfile

To change the appearance of the subfile: 

1. Back in the Properties dialog, under Style, select Subfile. 

The Subfile properties page opens on the right pane of the dialog. 
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2. Select Subfile record - odd row in the Subfile areas list. 

3. Under Background, click the [image: image134.png]


 push button to the right of the Color list. 

The Color Chooser dialog opens. 

4. Select light yellow. 
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Tip: If you are interested in the hex value of certain colors as they are used in the style classes, the Color Chooser dialog displays the hex values; see the value "FF FF CC” 

5. Click OK in the Color Chooser dialog. 

You return to the Properties dialog. 

6. Select Subfile record - even row in the Subfile areas list at the top of the page. 
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7. Under Background, click the [image: image137.png]


 push button to the right of the Color list. 

The Color Chooser dialog opens. 

8. Select a light green. 

9. Click OK on the Color Chooser dialog. 

Now at runtime the odd and even records will be displayed with different background colors. Next, you will customize the appearance of the command key push buttons.

Exercise 8.3: Customizing the appearance of command keys

To customize appearance of command keys: 

1. In the left pane of the Properties dialog under Style, select Command keys. 

The Command Keys properties opens on the right pane of the dialog. 
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2. Change the Foreground color for all three states of the buttons: 

· Default 

· Rollover 

· Button down 

Now you have finished customization. 

3. Click OK on the Properties dialog.

Exercise 8.4: Checking the new style

Let's see the new look of your application. 

To check the new style: 

1. Right-click wflabxx project. 

2. Click Run on Server on the pop-up menu. 

3. Run the application. 

4. Click Prompt. 

The application window shows different colors, and the subfile records are colored. The command key push buttons change color, depending on their state. 

If you don't see the changed colors, you need to restart the project, restart the Application server and then run the application again.

Recap

Congratulations! You have completed Working with more style properties. You should now understand how to: 

· Start the Style Properties dialog 

· Work with three different style properties 

· Check the changes by running the application 

You have tested your WebFacing application and for convenience have used your User ID and password as the default to avoid having to sign-on every time you started the application. Now you need to move the application into production and you need the WebFacing application to prompt the users for sign-on information when it starts. 
Continue to Adding authentication.

Adding authentication

In this chapter, you will learn how to secure your application by forcing authentication before the application is invoked. You will learn how to change the run-time behavior of your application. Instead of using the default User ID and password, the one you used when you selected the members to convert your DDS source, you will now force the user to provide their own sign-on information. You will learn how to remove the User ID and password from the CL command properties. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 9.1: Removing the default User ID and password 

· Exercise 9.2: Testing the authentication dialog 

The exercises in this chapter must be completed in order. Start with Exercise 9.1: Removing the default User ID and password when you are ready to begin. 

Length of time: 
This chapter will take approximately five minutes to complete.

Exercise 9.1: Removing the default User ID and password

You will use the CL command properties page of the runtime to remove the default User ID and password information. 

In the WebFacing perspective in the WebFacing project view: 

1. Right-click wflabxx project. 

2. Click Properties on the pop-up menu. 

The Properties for wflabxx dialog opens. 

3. Under Run Time in the left pane of the Properties dialog, select Order Entry Application. 
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The Order Entry application properties pane opens. 
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4. Make sure the Override project settings for this command check box is selected. 

5. Clear the Specify OS/400 signon values check box. 

6. Click OK at the bottom of the Properties dialog. 

You are back in the WebFacing project view. You have changed the authentication behavior for this link (application). In this WebFacing project you only have one link, but imagine that you have multiple entry points into your application like a menu. You could specify a different authentication behavior for each of these links. On the other hand, if you have multiple links in a WebFacing project and the authentication should be the same for each different link, then you can specify an authentication rule on the project level. To do this, just go to the project properties page instead of the CL command properties page and specify the desired authentication behavior there.

Exercise 9.2: Testing the authentication dialog

As before, you run your application in the WebSphere Application Server test environment. 

To test the authentication dialog: 

1. Right-click wflabxx project. 

2. Click Run on Server on the pop-up menu. 

3. Click the Order Entry link. 

You will see the authentication dialog. 
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4. Specify your User Name and Password. 

5. Click the Logon push button on the Authentication dialog. 

The application will run like before, if the job environment for the User ID you specified is setup correct for this application. 

Note: If the LOGON dialog doesn't appear, restart the Application Server. 

1. Click the Servers tab at the bottom view in the workbench. 

2. Right-click the server icon. 
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3. Click Restart on the pop-up menu. 

4. Run the application again.

Recap

Congratulations! You have completed Adding authentication. You should now understand how to: 

· Use the project properties dialog for the Order Entry application to remove the default User ID and password information. 

· Run the application and where forced to provide authentication before the WebFacing runtime would start the WebFacing application. 

You have created a WebFacing application and now want to enhance the look of the index.jsp page to give the start page of this application a professional appearance. The WebSphere Development Studio Client workbench contains several tools to design and enhance Web pages. Also with the workbench you have access to sample pictures, icons, animations, and more. You will use some of these tools and samples and enhance the page so it becomes more attractive. 
Continue to Enhancing index.jsp page.
Enhancing index.jsp page

In this chapter, you will learn how to use the Web tools in the WebSphere Development Studio Client workbench to update the index.jsp file. The index.jsp file created by the IBM WebFacing Tool that allows you to start your WebFacing application is plain. In this chapter you will add some color to it, as well as some pictures to make it a more interesting Web page. You will learn how to test the changed page. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 10.1: Opening Page Designer 

· Exercise 10.2: Working with page properties 

· Exercise 10.3: Linking a cascading style sheet to a Web page 

· Exercise 10.4: Designing and adding a logo 

· Exercise 10.5: Adding a heading 1 tag to the page 

· Exercise 10.6: Adding a picture to the page 

· Exercise 10.7: Adding moving text to the page 

· Exercise 10.8: Changing the text color 

· Exercise 10.9: Deleting default text from the page 

The exercises in this chapter must be completed in order. Start with Exercise 10.1: Opening Page Designer when you are ready to begin. 

Length of time: 
This chapter will take approximately 30 minutes to complete.

Exercise 10.1: Opening Page Designer

To open Page Designer: 

1. Open the WebFacing perspective, if not already open. 

You should now have the WebFacing Projects view in your workbench environment. 
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2. Expand the wflabxx WebFacing project. 

3. Right-click the index.jsp icon. 

4. Click Open on the pop-up menu. 

The Page Designer opens in the upper right pane of the workbench and shows the index.jsp page as the IBM WebFacing Tool created it. 
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Make sure that you are on the Design page in Page Designer. 

5. Click the Design tab.

Exercise 10.2: Working with page properties

Next you move the links down. 

To work with page properties: 

1. Click before the Select program to start title. 

2. Press the Enter key a number of times. 
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3. Right-click the background of the index.jsp page in Page Designer. 

4. Click Page Properties on the pop-up menu. 
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The Page Properties dialog opens. 
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5. In the Page title field, type Order Entry. 

6. Click OK on the Page Properties dialog. 

When this page is shown in a browser, the Window title bar of the browser will now display Order Entry.

Exercise 10.3: Linking a cascading style sheet to a Web page

Now you will add a style to the Web page. You can use a style that is used in your company or you can use one of the sample style sheets that are provided in WebSphere Development Studio Client. 

Next you open the Gallery view in the workbench. 

To link a style sheet: 
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1. Click the Gallery tab, if the Gallery view isn't already displayed. 

2. Scroll to the bottom of the Gallery view, until you can see the Style Sheet icon. 

3. Click the Style Sheet icon, to select it. 

4. Click the Thumbnails tab on the right bottom pane in the workbench. 

You should see thumbnail icons of all the styles available. 

5. In the thumbnail view, scroll down to the bottom, until you see style sheet waves001.css in the list, or select a style sheet that you like best. 

6. Click the thumbnail picture of waves001.css with the left mouse button. 

7. Hold the left mouse button down and drag the cursor to the Page Designer window. 

8. The cursor will change from this shape [image: image149.png]


, to this shape [image: image150.png]


. When the latter cursor shape appears in the Page Designer window, release the left mouse button. 

After a short while, the style sheet properties will be applied and the colors in the page will change to the style sheet definitions. 
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Exercise 10.4: Designing and adding a logo

Now that you have the overall Web page look specified, you will use the WebArt Designer to create a Logo that you then will add to this page.

Starting the WebArt Designer

To start the WebArt Designer: 
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1. Click Tools in the workbench menu. 

2. Click WebArt Designer on the pop-up menu. 

The WebSphere Studio WebArt Designer opens. 
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The WebArt Designer shows the Template Gallery on the left, where you find samples of logos, buttons, rollovers, images and more. The big white area in middle of the dialog is the canvas that is used to work with objects that you want to create or change. Although you could select a logo from the template gallery as the base for your own logo, you will instead create you own.

Creating the logo

To create the logo: 

1. Click the Create Logo button above the canvas or use the Object > Create Logo menu options. 
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The Logo Wizard opens. 
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2. Enter your company name in the Text field and in the next line of the Text field enter the project name. 

3. Select Comic Sans MS in the Font name list. 

4. Select 46 in the Font size list. 

5. Under Style, select Bold and Italic check boxes. 

6. Leave the Antialias check box selected. 

7. Click the Center radio button under Alignment. 

Notice in the upper right corner of the dialog, a sample of the logo is displayed. 

8. Click Next to go to the next page of the wizard. 

The Select Color page of the wizard opens. 
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9. Click the gradation Type push button, the middle one of the three type push buttons. 

Note: The other push buttons select color types: solid and textured. 

10. Select beer from the colors available, or any other color you like best, just scroll through the list to find a gradation you like. 

Tip: You can change the colors by clicking the Others push button on this dialog and create your own gradation. 

11. Click Next to move forward to the next page. 

The Select Outline page opens. 
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12. Select the Seal outline from the list, or any outline you like best. 

13. Click Next. 

The Select Text Effect page opens. 
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14. Select the Emboss text effect or one that you like best. 

15. Click Finish. 

You return to the WebArt Designer window with the new logo object. 
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Resizing the logo

To resize the logo object on the canvas: 

1. Click the logo object to select it. 

2. Move the cursor to the rectangle at the right bottom corners of the object, watch the cursor changing shape. 

3. Drag the rectangle up and to the left so the object becomes smaller. 

Now you need to save this object. First, you want save it as a WebArt object, which allows you later on to work with the object again in WebArt Designer. However, you can't use that format for your Web page, so you will also save it in another format.

Saving the logo as a WebArt object

To save the logo as a WebArt object: 

1. Click File on the WebArt Designer menu. 

2. Click Save Canvas As on the pop-up menu. 

The Save Canvas As dialog opens. 

Note: Make sure you save the canvas in your workspace. 
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3. Type mylogo in the File name field. 
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4. Click Save. 

Now you save the object in a form that can be displayed on a Web page.

Saving the object for a Web page

To save the logo object for a Web page: 

1. Click File from the WebArt Designer menu again. 

2. Click Save Wizard for Web on the pop-up menu. 

The Save Wizard dialog opens. 
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3. Leave the Save the selected objects radio button selected. 

4. Click Next. 

Now the Select File format page opens. 
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5. Leave the GIF radio button selected. 

6. Click Next. 

The GIF Format page opens. 
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7. Click Finish. 

The Save As dialog opens. 
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8. Type mylogo in the File name field. 

9. Click Save. 

Next, you close the WebArt Designer. 

10. Click File from the menu. 

11. Click Exit on the pop-up menu. 

You are back in the workbench in the WebFacing perspective showing the WebFacing Projects view. 

Next you switch to the Navigator view to locate the logo object mylogo.gif and to place the logo on the Design page. 

Note: You may have to click Window > Show view > Navigator from the workbench menu.

Placing the logo on the Design page

To place the logo on the Design page: 

1. Click the Navigator tab. 

2. Expand the wflabxx Web project if not already expanded. 

3. Expand the WebContent folder if not already expanded. 
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The mylogo.gif file should appear in the list. If it doesn't appear, refresh the list. 

4. Right-click the WebContent folder icon. 

5. Click Refresh on the pop-up menu. 

Hopefully, you can see the file now in the Web Content folder; if not, go to Windows Explorer and search for the mylogo.gif on your hard drive. Move it to the Web Content folder in the WebSphere Development Studio Client workspace. If you didn't use the default workspace location, do a search for the workspace and the wflabxx directory in it. Move the mylogo.gif into the WebContent directory under the wflabxx directory. Refresh the Navigator view again. 

Now, you can take the logo and put it on your Web page that is still open in Page Designer. If Page Designer has been closed just open the index.jsp file. Make sure you are on the Design page, not the Preview page. 

6. In the Navigator view, select the mylogo.gif file. 

7. Hold the left mouse down. 

8. Drag the file to the upper left corner in the Page Designer window. 

9. Release the mouse button. 

The logo is placed on the Design page. 
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Exercise 10.5: Adding a heading 1 tag to the page

Now, you want to insert a heading below the logo. 

To add a heading 1 tag: 

1. Position the cursor just below the Logo at the first BR tag. 
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2. Click Insert from the workbench menu. 

3. Click Paragraph > Heading 1 on the pop-up menu. 

A frame appears that allows you to enter text. 

4. Enter your company name Order Entry Application. 
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Now, you want to use one of the sample pictures included with WebSphere Development Studio Client and place this picture on the page.

Exercise 10.6: Adding a picture to the page

To add a picture to the page: 
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1. In the workbench in the Navigator view, select the Gallery tab. 

2. Expand the Image folder. 

3. Select the Illustration folder. 

4. In the Thumbnails view beside the Gallery view, select one of the sample illustrations, for example, use file 005il.gif. 

Note: The sample illustrations change from release to release so 005il.gif might not be available in your environment. 

5. Drag a picture onto the Design page below the heading. 

The Design page now contains a picture. 
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You are almost done. Next, you add moving text to the page.

Exercise 10.7: Adding moving text to the page

Now you add moving text to the page. 

To add moving text: 

1. Position the cursor in the Design page underneath the picture. 

2. Click Insert from the workbench menu. 

3. Click Paragraph > Heading 3 on the pop-up menu. 
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4. Leave the cursor positioned inside the heading 3 frame:
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5. Click Insert from the workbench menu. 

6. Click Others > Marquee on the pop-up menu. 

The Insert Marquee dialog opens:
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7. Enter into the Text field, Please select link to start application. 

8. Under Behavior, select Slide in the Movement list. 

9. Under Repetition, select Finite in the Repetition list. 

10. Under Repetition, type “1” in the Count field. 

The two last selections just avoid the text sliding in forever and not standing still. If you want more movement on the page you can change these settings. 

11. Select Lime in the Background color list. Click OK on the color palette. 

12. Click OK on the Insert Marquee dialog. 

The Design page should look like: 
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Next, you save some space by removing some of the line break tags. 

13. Position the cursor on the BR tag. 

14. Press the Delete key until the SELECT PROGRAM TO START title appears on your page. 
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Next, you look at the page, as it would appear in a browser. 

15. Click the Preview tab at the bottom of the Design page. 

You will notice that your heading three text is sliding in. 

[image: image177.png]b25]
lufiabid
IBM Order Entry Application

B





Exercise 10.8: Changing the text color

You notice that the Text color and the background are not easy to distinguish from each other. One way of changing this, is to apply another color to a certain area of the text. To do that, you have to return to the Design page. 

To change the text color: 

1. Click the Design tab. 
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2. Select the company text (IBM) you want to change color on, by selecting the text area with the mouse cursor. 

3. Under the Design page, select the Colors tab. 

4. In the Colors view, select a color with your mouse cursor. 

5. Click the down arrow next to the Text Color from the Colors view. 

6. Click Set as Text Color on the pop-up menu. 

You are done; now the selected text will be displayed with the color you selected for it.

Exercise 10.9: Deleting default text from the page

Now, you want to remove the default text that was added by the IBM WebFacing Tool. 

To delete default text from the page: 
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1. Select the text. 

2. Press the Delete key. 

3. Select the Preview tab to view your completed page. 
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4. Close the file index.jsp. 

5. Click Yes to save the changes. 

Page Designer is closed. 

6. In the Navigator view or WebFacing Projects view, right-click wflabxx. 

7. Click Run on Server on the pop-up menu. 

Your new designed index.jsp page opens and you can run your application. 
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Recap

Congratulations! You have completed Enhancing index.jsp page. You should now understand how to: 

· Open Page Designer 

· Work with page properties 

· Link to a cascading style sheet 

· Create a heading 

· Add an image 

· Create a logo and add it 

· Add a marquee 

· Change the color of text 

· Delete default text 

Export/Import IBM WebFacing Tool projects in WebSphere Development Studio Client
There are several ways to Export and Import IBM WebFaced Applications including .WAR (Web Archive), .EAR (Enterprise Archive), and .Zip file formats. The .WAR and .EAR files are J2EE specifications and can be used to deploy WebFaced Applications to servers. These file formats can also be imported into WebSphere Development Studio Client and be viewed as WebProjects from a Web perspective. However, they will not be visible in the WebFacing Perspective so changes using the IBM WebFacing Tool would be impossible.

Customers who wish to be able to Export/Import IBM WebFacing Tool projects and still have them visible in the WebFacing Perspective will need to use the .ZIP file format. This example will focus on how to export an IBM WebFacing Tool project such that it can be imported into WebSphere Development Studio Client, and still be worked from within the WebFacing Environment.

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Export your IBM WebFacing Tool project from WebSphere Development Studio Client
· Clean up WebSphere Development Studio Client
· Import your IBM WebFacing Tool project into WebSphere Development Studio Client
Length of time: 
This chapter will take approximately 10 minutes to complete.

Exercise 11.1: Export the IBM WebFacing Tool Project

In this step, we will be exporting your IBM WebFacing Tool project from WebSphere Development Studio Client. It is important that you follow the instructions correctly because the file you are creating will be used to recreate your project later in this section.

Export your IBM WebFacing Tool project
1. From the WebFacing Perspective, select File|Export. This will display a dialog box. Select Zip File in the Dialog Box, and then press the Next button. 

[image: image182.emf]


2. On the next dialog box that is displayed, verify the WFLabxx is selected. Click the Browse Button and browse to the Desktop. Type in WFLabxx. The dialog box should look similar to below. 
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3. Press Finish. This will create a .zip file called WFLabxx.zip on the Desktop. This file could be passed to another developer or customer who could then use it to import into the WebSphere Development Studio Client to be used in the WebFacing perspective.

Exercise 11.2: Cleanup WebSphere Development Studio Client Environment

Before we import our IBM WebFacing Tool project back into WebSphere Development Studio Client, we need to remove the project that is already there. 

1. Go to the Navigator view in the WebFacing Perspective and highlight both the WFLabxx and WFLabxxEAR folders. Right click on them and select Delete. On the dialog box that follows, select “Also Delete the contents of the file system” as shown in the following screenshot. Once you have done this, your existing project in WebSphere Development Studio Client no longer exists. 

[image: image184.emf]


Exercise 11.3: Import IBM WebFacing Tool Project into WebSphere Development Studio Client
Import into WebSphere Development Studio Client
We are now ready to import a WebFacing project into WebSphere Development Studio Client. Before that can happen we must unzip the WebFacing project .ZIP file.  
1. Double click on the .ZIP file created earlier and unzip this file in C:\temp. Once unzipped, the directory under the Temp file should look similar to the following screen shot: 

[image: image185.emf]


2. From WebSphere Development Studio Client, select File > Import. On the dialog box that is displayed, select WebFacing Projects. 
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3. Click the Next button. On the next dialog box, browse to the C:\temp\WFLabxx directory and press Next. 
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4. On the next dialog box, make sure the WFLabxx WebFacing Project is selected. 
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5. Press Finish. This will import the WFLabxx WebFacing project back in to the WebSphere Development Studio Client Environment. Go back to WebSphere Development Studio Client and select the WebFacing perspective. The WebFacing project should now be restored.
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Recap

Congratulations! You have now completed the Export/Import IBM WebFacing Tool projects in WebSphere Development Studio Client section. You should now understand how to: 

· Export your IBM WebFacing Tool project from WebSphere Development Studio Client
· Clean up WebSphere Development Studio Client environment
· Import your IBM WebFacing Tool project into WebSphere Development Studio Client
Exporting to iSeries WebSphere Application Server Express 5.1

You have tested the WebFacing application in the WebSphere Application Server test environment and you are ready to move it to your iSeries WebSphere Application Server production environment. You are running WebSphere Application Server (V5.1) on your iSeries server. 

In this chapter, you learn how to publish your WebFacing files to a remote WebSphere Application Server (V5.1) environment on an iSeries host server. You will start the Export tool in WebSphere Development Studio Client, specify files to export, install, and start the Web application in the WebSphere Application Server Administrative console. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 11.1: Exporting the files to the Web server 

· Exercise 11.2: Exporting your EAR file 

· Exercise 11.3: Installing the application 

· Exercise 11.4: Testing the WebFacing application 

The exercises in this chapter must be completed in order. Start with Exercise 11.1: Exporting the files to the Web server when you are ready to begin. 

Length of time: 
This chapter will take approximately 30 minutes to complete.

Exercise 12.1: Exporting the files to the Web server

First, copy the WebFacing project files to a WebSphere Application Server (V5.1). These first steps are the same for WebSphere Application Server for iSeries (V5.1) and the WebSphere Application Server for iSeries Express (V5.1). 

Before you export any files, you must map a network drive to the Root file system on the iSeries server where WebSphere Application Server is installed. 

To map a network drive: 

1. Right-click the Network Neighborhood or (My Network Places) icon on the desktop. 

2. Select Map Network drive on the pop-up menu. 

The Map Network Drive dialog opens. 
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3. In the Folder field, enter two backslashes \\ and the Netserver name of your Web server, and then \QIBM, for example: \\iSeriesServer\QIBM. This is a default share on iSeries servers. If the share is not active, you will have to activate it or create a new share using iSeries Navigator. 
4. Click Finish. 

You now have an additional drive available on your workstation and are ready to export your WebFacing project files.
Exercise 12.2: Exporting your EAR file

The J2EE standard has the concept of an Enterprise Archive File (EAR). This file is a Zip file that contains all information about your Web application. In the workbench, this file is built automatically for Web projects. Since your WebFacing project is a Web project, the wflabxxEAR file exists already. You only have to move it to the application server, point to it, and then install the application. There is no need to know about the structure of the application. Everything is handled in the workbench. Return to the WebSphere Development Studio Client workbench. 

To export your EAR file: 

1. In the WebFacing perspective, click File from the workbench menu. 

2. Click Export on the pop-up menu. 

The Select page of the Export wizard opens. 
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3. Select the EAR file icon. An EAR file is a compressed Enterprise Application Archive, and it contains all the files needed for the Web application. 

4. Click Next. 

The EAR Export page opens. 
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5. Select the name of the resources you used when creating your WebFacing project. This should be wflabxxEAR from the Enterprise Application project name list. 
6. In the Destination field, specify where you want to put the EAR file by entering the drive and directory structure of the IFS drive you mapped in the steps before. For example, use the default directory structure for installable applications for WebSphere Application Server Express. This path is dependant on the version and naming of your WebSphere Application Server and instance naming. It is not so important where you put it, but that you can find it when you try to install it.
x: is the drive letter mapped from your iSeries host in the previous steps. 

7. Select the Overwrite existing files without warning check box. 

8. Click Finish. 

If you see a message asking you to create a directory or delete an existing file, Click OK or Yes and continue. Now you can install the application in WebSphere Application Server.
Exercise 12.3: Installing the application

At this point, you should already have WebSphere Application Server and the associated HTTP server on your iSeries server set up and started. The port number of the HTTP servers Administrative Console (referred to as port#a) and the port number to run your application (referred to as port#b). The second one is the port number of your HTTP server that is set up to work with your application server. These values were determined by you during their configuration.
To install the application: 

1. Open any Web browser and type: http://servername:port#a/ in the Address field. 

Note: The default administrative port number for the HTTP server is 2001. 

The Login dialog appears. 

2. Type your iSeries User ID in the User ID field. 

3. Type your iSeries password in the Password field. 

4. Click OK. 

The browser opens. 
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5. Click IBM HTTP Server for iSeries from the iSeries Tasks menu. 

The Administration pages for the HTTP and application servers display. 

6. Select the Manage Tab. 

The Manage Application Server - Express page displays. 
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7. Select your WebSphere Application Server instance from the Server list.  

8. Click Install New Application under the WAS Wizards list. 
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The Install New Application page displays. 
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9. Click the Application is contained in an EAR file radio button. 

10. Specify the location of your EAR file (the file that you exported in the previous step). 

You can use the Browse push button to locate the file. 

11. Click Next. 

A page appears with options for application installation. 
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12. In the Application name field, type wflabxx. 

13. You can select the Pre-compile JSPs check box to speed up the process of showing the page the first time. (JSPs are compiled into servlets when first generated.) 

14. Click Next. 

The Map Virtual Hosts Page appears. 
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15. Click Next. 

16. Click Next. 

The application summary page displays. 
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17. Click Finish. 

After the successful installation, you see a page where you can manage the installed applications. 
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18. Click Manage Installed Applications under Applications. 

A page with the installed applications displays. 
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19. Click the wflabxx radio button in the list of installed applications. 

Start the application with wflabxx in the enabled state. 

[image: image202.emf]


20. Click the wflabxx radio button. 

21. Click Start. 

Now you are ready to test your WebFacing application.

Exercise 12.4: Testing the WebFacing application

To test the Web application: 

1. Open Internet Explorer and type http://servername:port#b/WFLabxx in the Address field. 

Your application index.jsp page should open. If it does not, double-check the URL and the port number. 
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Recap

Congratulations! You have completed Exporting to iSeries WebSphere Application Server Express 5.1. You should now understand how to: 

· Export files created by the IBM WebFacing Tool to a remote WebSphere Application Server 

· Publish and deploy your application in a real production environment
IBM WebFacing Tool Deployment Options

The goal of this section is for you to learn and understand different options available to you in the deployment of your IBM WebFacing Tool application. In customer situations, these options become very valuable for performance, uptime, and other business reasons. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 13.1: Learn how to accomplish Partial Deployment of an updated IBM WebFacing Tool Application

· Exercise 13.2: Understand JSP Pre-Touch and JSP Compilation

· Exercise 13.3: Configuring the Pre-Touch Attributes

Length of time: 
This chapter will take approximately 45 minutes to complete.

Exercise 13.1 Partial Deployment

There may be occasions where after successfully deploying an IBM WebFacing Tool application to a customer site, it may be necessary to update the deployed WebFaced application. In a business setting, most customers will not want to uninstall an entire WebFaced application and reinstall a completely new application.

It is possible to partially deploy only the parts of an IBM WebFacing Tool application that have changed. This would mean deploying any DDS source(s), the reconverted JSP file(s), and the associated XML file(s) to their proper location within the integrated file system or IFS.

1. Recall that the IBM WebFacing Tool generates two JSP files and an XML file for every DDS source file record. By default, all the XML files generated are placed in a single .jar file to decrease the number of generated files for deployment. The file name where all of these XML files are stored is called DDSGeneratedData.jar.
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A screen shot of an expanded WFLabxx Application in the WebFacing Perspective is shown below. 

[image: image205.emf]


2. Notice that for the ORDENTD DDS source for the Prompt record there is a Prompt.JSP, a PromptJavaScript.jsp, and a PROMPT.xml file. This would mean that a change to the PROMPT record of the ORDENTD DDS Source file would require deployment of the PROMPT.xml, PROMPT.jsp, and PROMPTJavaScript.JSP files.
3. Looking at the deployed application using Internet Explorer, we can see the Prompt.jsp and PromptJavaScript.jsp files.
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4. The DSPGeneratedData.jar file is located in the WEB-INF/Lib directory. As shown below:

[image: image207.png]vew

 Address | 7:\UserDatal\tebAS51\Base \WLabxxWASServer nstalicApps Series_WFLabxxWASServerfiabioc ear WFLabio.war WES-INF i

X Neme

& (2 Defauitappiication. ear
& D ivtapp.car
& D whabxx.ear
& 2 METAIN
& D WRLabxx.war
# (2 Documents and Settings
2 METAIN
& 2 theme
& [ webfacing
# [ Clientsaript.
3 images.
EI=30)
& [ common
& [ Dpsrecords
= 2D wrLABXX
= 2 Qoosse
& 3 oroENTD
& hml
@ [ streuso
@ [ sLTPARTD

() WRKORDFM

D services
O styles
& 2 uMHep
& D wes-Iw
# ) dasses
Qi

H Bjacun

| B commnors bt o
(5] commons-colectons jar

[5] commons-digester.jar

5] commons-fieupload.jar

5] commons-ang jar

5] commons-ogging.jar

(5] commons-vakdator jar

5] D0SGenerateddata ar

b

5 jakerta-ora.jar

[0

[Slstartrracng bat

B struts or

] TracngReade.txt

[ wrrun

6] whtrutsjor

Bl whviewar





5. Open the File using a .zip utility. Notice that all of the XML files for all of the DDS records are stored in this file. Notice the path associated with each XML file. In the example below, the path to PROMPT.xml is APILIB/RPGAPP/ORDENTD. This will be important to know for the later partial deployment.
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IBM WebFacing Tool Partial Deployment

The IBM WebFacing tool does not provided any tools for partially deploying application code changes. Partial deployment is really a manual process. The process may be made easier by developing a tool to perform the steps. For the purposes of this example, we will perform these steps manually.

For this example instead of changing DDS source file(s) and reconverting, we will manually make a change to the Prompt JSP file to simulate a DDS Source file change. Remember, when the DDS Source is changed for this file three files need to be copied: PROMPT.jsp, PROMPTJavaScript.jsp, and PROMPT.XML.
1. Double click on PROMPT.jsp to open it and switch to the Source view by clicking on the Source tab. Search for the Parts Order Entry text “Parts&nbsp;Order&nbsp;Entry” as shown below.  

[image: image209.emf]


2. Change the Parts Order Entry Text to “ABC Company &nbsp;Order&nbsp;Parts” as shown below. 

[image: image210.emf]


3. Save your changes and test the changes from within WebSphere Development Studio Client. The changes should be visible on the very first screen. 

[image: image211.emf]


4. Before you can deploy the sources to the running iSeries server, you will have to get the sources necessary from WebSphere Development Studio Client. The three files to deploy are: PROMPT.jsp, PROMPTJSavaScript.jsp, and PROMPT.XML. Because PROMPT.XML in the DDSGenerated.jar file is archived, you will need to export this file to the file system to be able to extract PROMPT.XML. These would be the three files that could have changed if the DDS source had changed.

You will need to locate these three files and export them. Use File > Export and select File System. 
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There are two screen shots to illustrate where the fields are located. Export the files to c:\temp. 
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5. Open the DDSGeneratedData.jar file with PKZIP and extract the PROMPT.XML File.     

[image: image215.emf]


6. When you are finished, the file system should look similar to the following.

[image: image216.emf]


Notice when we extracted PROMPT.XML we left the directory structure in tact.

7. Now copy the PROMPT.jsp, PROMPTJavaScript.jsp, and the APILIB directory structure containing PROMPT.XML to the iSeries server.

8. The Correct directory for the PROMPT.jsp and PROMPTJavaScript.jsp files are shown below. The path can vary a little base on what version of WebSphere Application Server you are working with. 
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9. Copy the APILIB directory to the classes directory as shown below. Copying the XML file to the classes directory will cause the WebSphere Application Server to pick up the XML file(s) from this directory structure before it picks up files in the lib directory. 
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10. Stop and restart your instance of WebSphere Application Server. Once restarted, you should see your changes. 
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Exercise 13.2 JSP Precompile Options

WebSphere Application Server for iSeries has a unique feature known as JSP Pre-Touch for precompiling JSP files.

What is JSP Pre-Touch?

JSP Pre-Touch is a tool for compiling and class loading JSPs during application startup. It is configured via a series of initialization parameters that are added to a Web module’s ibm-web-ext.xmi file.

JSP Pre-Touch is used to compile JSPs and reduce the amount of time it takes to invoke a JSP after an application is first started (called “first touch”), even when the JSP has already been compiled. 
When to use JSP Pre-Touch

The JSP Pre-Touch mechanism should be used when all JSPs need to be compiled asynchronously.

A secondary use is to class load all JSPs for an application into WebSphere Application Server. This removes the class load penalty paid by the first user to access a JSP file.

When not to use JSP Pre-Touch

Avoid running the Pre-Touch tool in large application startup in production environments. Loading large numbers of infrequently used JSPs up front has tradeoffs. It can significantly increase the JVM heap size which can cause memory bottlenecks at startup and during garbage collection cycles. 

JSP Compilation

To enable the JSP Pre-Touch, there are three possible attributes that can be configured. Each of the attribute settings reside in the ibm-web-ext.xmi file of a Web module (found in the WEB-INF directory). Setting the parameters in this file can be achieved using the WebSphere Development Studio Tools, the Application Assembly Tool, or any text editor. 

The two most important attributes are prepareJSPs and prepareJSP. The third attribute, prepareJSPThreadCount, can be used on multi-processor systems.

prepareJSPs 

When the attribute, prepareJSP, is present all JSP files will be compiled on WebSphere Application Server startup. This process happens in a separate thread, so the WebSphere Application Server may, depending on the quantity and size of JSP that the application has, finish starting up before the JSP files are finished compiling. If starting and running the Web-enabled application seems slow, it could be because the JSP files are still compiling. Check the server log files to know when all of the JSP files have been compiled.

The numeric attribute value represents the minimum size (in kilobytes) that a JSP must be in order to also be class loaded and JIT-compiled. The default is 0, which causes all JSPs to be class loaded and JIT-compiled.

prepareJSP Attribute

Set the prepareJSP attribute to a value that is a request parameter composed of an alphanumeric that the JSP never expects to otherwise receive. This attribute is used to perform a quick exit from the service method of each JSP when they are prepared by this tool. This enables the tool to work much faster and prevent exceptions from showing in the WebSphere Application Server logs as a result of executing the JSP at startup. 

If this attribute is not set on a Web-enabled application but the prepareJSP attribute is set, exceptions will be thrown by the application when the service method for the JSP is called because the WebFacing runtime has not been initialized. This will put many error messages in the log, use heap space, and cause the garbage collector to run. Here is a good rule of thumb — if precompiling the JSP, use the prepareJSP attribute setting as well.

Exercise 13.3 Configuring the Pre-Touch Attributes
The Pre-Touch attributes can be configured using the WebSphere Development Studio Client

1. To set the attributes, open the Web Perspective, then open the ibm-web-ext.xmi file. 
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2. Open the webappext element. Right click the webApp element and select Add After as shown in the next screen shot.
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3. In the dialog that appears, type jspAttribute and press OK. 
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4. Highlight the newly created attribute, right click, select Add Attribute > New Attribute as shown below. 

[image: image223.emf]


5. In the dialog box that appears, make it match the following screen and press OK. 
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6. Continue this process until the screen looks like the screen below. To summarize, there are two jspAttributes elements to be added. One jspAttribute has an attribute xmi:id with a value of JSPAttribute_1, a name attribute with a value of prepareJSPs, and a value attribute with a value of 0. The second jspAttributes entry has an attribute xmi:id with a value of JSPAttribute_2, a name attribute with a value of prepareJSPAttribute, and a value attribute with a value of JunkEntryPoint. Note: Everything is case sensitive so type things as defined in the screen shot. 
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7. Save the changes once completed. To see what the changes look like in raw xml format, click the source tab from within the WebSphere Development Studio Client environment located near the bottom of the XML editor. Notice the jspAttributes that have been added to the file. These entries could be made manually to a deployed WebFaced application by editing the ibm-web-ext.xmi file. After all JSPs have been compiled, it’s a good idea to remove these entries which can be done manually using a normal text editor. Failure to remove these entries will cause all JSPs to be class loaded upon WebSphere Application Server startup. As mentioned earlier for large applications, this could introduce resource issues. For smaller applications, leaving these entries in an XML file will work well. 

[image: image226.emf]


8. Once you have added the jspAttributes settings test the changes. This is done by deploying the application to WebSphere Application Server on iSeries as done earlier. We will not walk you through those steps so refer to how to deploy the application in exercise 12. You will either have to stop your currently running WFLabxx application or deploy a WAR file with a different context root. Once the application is installed, start the application server. When the application server is started, WebSphere Application Server should start to compile the JSP files. This can be verified by viewing the System.out log file.  

To begin, open the mapped drive to the iSeries server.

The SystemOut.log file will be located in the

/<InstanceName>/logs/ directory of your WebSphere Application Server instance.
9. Using Internet Explorer you should be able to find it. Open the System.out log file using the editpad lite application installed on your PC. Both NotePad and WordPad will be unacceptable for viewing the log file. Scroll down in the log file until you find a line similar to: 
[9/1/04 8:25:07:078 UTC] b29ffde8 SystemOut     O PrepareJspHelper in group [WFLabxx]: 25 jsp files have been processed.
Every 25 JSP files, WebSphere Application Server writes this entry to the log file. You may need to refresh the editor until you see this.  

Eventually you should see an entry similar to: 
[9/1/04 8:25:09:935 UTC] b1af809f SystemOut     O PrepareJspHelper in group [WFLabxx]: All 71 jsp files have been processed.
The important thing to look for is the “All.” This means that all JSP’s have been compiled and class loaded. 
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10. The next step in the process would be to remove the jspAttributes setting. This may not be required for small applications, but for large applications typically you would not want all JSP’s class loaded. The entry in the jspAttributes settings in ibm-web-ext.xmi should be removed. Remember that when you deploy an application to WebSphere Application Server, the ibm-web-ext.xmi exists in two places. One is located the installed apps directory:

[image: image228.emf]


This is NOT the one to change. Think of it as the “Prod” data side of the application.

The other file “cells” directory as shown below:

[image: image229.emf]


This is the ibm-web-ext.xmi file that is edited.

11. To remove these entries, open the file with editpad lite. Remove the two jspAttributes lines. 

[image: image230.emf]


12. Save the file.

13. Stop and restart your server.  

14. Go back into the System.out log file. For the latest restart of the server, the JSP precompiler would not try compiling the JSPs.
Recap

Congratulations! You have completed the IBM WebFacing Tool deployment options section. You should now understand how to: 

· Partially deploy an IBM WebFacing Tool application

· Use Pre-Touch and JSP Precompile 

Creating a WebFacing Portlet project

In this chapter, you will learn how to create a WebFacing project that will run as a portlet inside a Portal server. For this chapter, you will convert the Order Entry application used previously. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 14.1: Starting the WebFacing Web Portlet Project wizard 

· Exercise 14.2: Selecting display file members to convert 

· Exercise 14.3: Specifying the CL command to launch the application 

· Exercise 14.4: Selecting a Web style 

· Exercise 14.5: Completing the WebFacing project information 

· Exercise 14.6: Creating the Portal test server

· Exercise 14.7: Adding the portlet project to the portal server

· Exercise 14.8: Staring the portal server

· Exercise 14.9: Testing the WebFacing portlet application

The exercises in this chapter must be completed in order. Start with Exercise 14.1: Starting the WebFacing Web Portlet Project wizard. 

Length of time: 
This chapter will take approximately 30 minutes to complete.

Exercise 14.1: Starting the WebFacing Web Portlet Project wizard

To start the WebFacing Portlet Project wizard: 

1. In the WebFacing perspective, click File > New > Project from the workbench menu. 
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The New Project dialog is displayed 
2. In the left pane, select WebFacing.

3. In the right pane, select WebFacing Portlet Project.
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4. Click Next.

This will start the WebFacing Portlet Project wizard. 
5. In the WebFacing Portlet Project wizard, you will be presented with the Create a WebFacing Portlet Project page.
[image: image233.png]4 webFacing Portlet Project

WebFacing Portlet Project
Create a WebFading Portet Project.

You can creste 3 new WebFacing portiet application project, or add 3 WebFacing portlet o an exdsting portlet application project,

 Create a new J2€E 1.3 WebFacing portet project

eroject name: ([wlsborortet]

Project location: [ Di\WorkSpacs\wdsc_512_GM_FP1_HywflabxxPortlet

o

£AR proec: [WRDOPOTHERR

il 0ebaciv portet e exiting pertet applation project

|z, |

WebFacing profect features:

T~ Add system screen support
T~ Use single signon

Cancel

<ok (‘ Ern





6. In the Project name field, type the project name wflabxxPortlet. 

The Enterprise Archive (EAR project) File will be updated automatically. 

This will create a unique Application file for this WebFacing project. 

7. Click Next. 

8. The Select Display File Source Members to Convert page opens. 
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Exercise 14.2: Selecting display file members to convert

On this page of the WebFacing Portlet project wizard, you need to specify the name of the iSeries server that contains your display file DDS source, as well as which members of the source file you want to convert. Specifically, the IBM WebFacing Tool needs to know these names: 

· Server name 

· Library name 

· Source file name 

· Member name 

1. Ensure *LIBL is selected in the Library list. 
Click Refresh DDS list. 

[image: image235.png]Select Display File Source Members To Convert

Select "Refresh DDS lit" ta refresh the lbrary items dspla
able for conversion.

Project name: | wiabxx -
Connection: [s400a
Ubrary: [N ~] Fie: [

Click Refresh DDS lst button , then select files o merber





If this is the first time you have used this connection, the Enter Password dialog opens. 
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2. In the User ID field, type your iSeries User ID. 

3. In the Password field, type your iSeries password. 

4. Select the Save user ID check box. 

5. Select the Save password check box. 

6. Click OK. 

A connection to the iSeries server gets established. The library list of your iSeries job is displayed under the Refresh DDS list button on the Select Display File Source Members to Convert page. 
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Selecting DDS members

To select DDS members to convert: 

1. Select the WFLABXX library from the list. 

2. Click the plus sign (+) beside the WFLABXX library to expand it. 
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3. Expand the QDDSSRC source file. 

4. With the Ctrl key pressed on the keyboard, click on the members ORDENTD, SLTCUSTD and SLTPARTD. 

5. Click [image: image239.png]


 push button in the middle of the page to copy the selected members over to the list of members to be converted at the right. 

Next, you convert UIM source members.

Selecting UIM source members

To select UIM source members to convert: 

1. Click Next to proceed to the next page of the wizard. 

The Select UIM Source Members To Convert page opens. 
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Now, you have to identify the panel group source containing the help information for the Order Entry application. 

2. Click the Refresh UIM list push button. 

3. Expand library WFLABXX. 

4. Select the QPNLSRC source file from the expanded list of library WFLABXX. 

5. Click the [image: image241.png]


 push button in the middle of the page to copy all members over to the list of members to be converted at the right. 

There is actually only one panel group member ORDENTRPNL in this source file. 

6. Click Next to proceed to the next page of the wizard. 

The Specify CL Commands page opens.

Exercise 14.3: Specifying the CL command to launch the application

You will now provide the information that will allow the WebFacing Portlet Project wizard to create the initial index.jsp page to start the Order Entry application. 
To specify the CL commands: 

1. In the CL command field, type CALL ORDENTR 

2. In the Command label field, type Order Entry Application. 

3. Leave the default value INV1 in the Invocation name field. 

4. Click the Specify OS/400 signon values radio button. 

5. Click Add on the right side of the page. 
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Note: Make sure the text and command you typed into the fields are actually shown in the CL Command table at the bottom of the page. 

6. Click Next at the bottom of the wizard page. 

The Choose a Web Style page opens.

Exercise 14.4: Selecting a Web style

Next, select a Web style for your converted screens. 

To select a Web style: 
1. Select the 3DButtons style from the list of available styles. 
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2. Click Next. 

The Complete WebFacing Project page opens.

Exercise 14.5: Completing the WebFacing project information

On this page, you have a choice of creating the project and converting the source in one step or only creating the WebFacing project. 
To complete the WebFacing project information: 

1. Select the Yes. I want to create the project and proceed with conversion now radio button. 
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2. Click Finish. 

The WebFacing Portlet project is created, and the DDS is converted. The workbench opens in the WebFacing perspective with your new WebFacing portlet project in the WebFacing Projects view. 
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Exercise 14.6: Creating the Portal test server

Before we can test the new WebFacing portlet, you must create a Portal Test Server. The WebFacing portlet will be published to this new server.

To create a Portal test server:
1. In the WebFacing perspective, select the Server Configuration tab:
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2. The Server Configuration view opens.
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3. Right-click anywhere in the Server Configuration view, and select New > Server and Server Configuration from the pop-up menu.

4. The Create a new server and server configuration dialog is displayed.
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5. In the Server name, type a name for the portal server, such as Portal Server.

6. Expand the WebSphere Portal version 5.0 folder.

7. Select Test Environment.

8. Click Finish.

The new portal server will be created in the Server Configuration view:
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Exercise 14.7: Adding the portlet project to the portal server

Now, you must add the new WebFacing portlet project to the portlet server.

To add the project:

1. Right-click on the Portal Server configuration.
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2. From the pop-up menu, select Add and remove projects.
3. The Add and Remove Projects dialog is displayed.
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4. In the left pane, select the wflabxxPortletEAR project.

5. Click Add >.

6. The project will appear in the right pane.

7. Click Finish.

8. The project will be added to the portal server in the Server Configuration view:
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9. Expand the Portal Server configuration to see the projects published to this server.

Exercise 14.8: Starting the portal server

To test the WebFacing portlet application, you must start the portal server. However, before you do so, you must ensure no other servers are running. This is due to the fact, that by default, the test servers share the same port numbers.

To stop any running servers:

1. Click on the Servers tab. This is usually located in the lower right corner of the workbench.

[image: image253.png]New »
Open

Delete

% oebug
K st

e
5

& Discoree

£ b

Skeh Confiuration ,
Restar Project »
g A remove rojects

Run universaltest client
Restart universal tes clent
R edriistrative consol

Creste tables and data sources @ x
Server [ St 0 o activty Lo

T e

. |
e (EST) e







2. If a server is shown with a status of Started, it must be stopped.

3. Right-click on the server, and select Stop from the pop-up menu.

4. The view will switch to the Console view.

[image: image254.png]34sp0£es
3asp0£es
3asp0£es
3asp0£es
3asp0£es
3asp0£es

3asp0£es
3asp0£es
3asp0£es
3asp0£es
3asp0£es

WebCantainer
WebGroup
WebGroup
WebGroup
Applicationtiy
applicationtiy
WebCantainer
WebGroup
WebGroup
Applicationtiy
ServerCollabo

SRVEDL70T:

SRVED180T

SRVED180T:

SRVED180T
WSVRO220T
WSVROZ17T
SRVED170T

SRVED180T:

SRVED180T
WSVRO220T
WSVRODZ4 T

Stopping Web Module: wflsbxx.
[vflabxx] [/vElabxx] [Serviet
[wflabxx] [/vElabxx] [Serviet
[wflabxx] [/vElabxx] [Serviet
Spplication stopped: wElabxxE,
Stopping application: IBNUTC
Stopping Web Module: IBH Univi
[IBN Universal Test Client] [
[IBN Universal Test Client] [
IBHUTC

Server serverl stopped




5. Wait unit the message appears in the console indicating the server has stopped.

6. Click on the Servers tab again to return to the Servers view. 

7. Right click on the Portal Server, and select Start from the pop-up menu.
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8. The view will again switch to the Console view.
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9. The portal server does not display a message indicating it has started, so refer to the figure and wait until the console displays the messages shown.

Exercise 14.9: Testing the WebFacing Portlet application

Now that the portal server has been configured, the portlet has been published to the portal server and the portal server is started, you can test the WebFacing portlet.

To test the portlet:

1. In the WebFacing view, select the WebFacing projects tab.

2. The WebFacing projects are displayed.
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3. Right-click on the wflabxxPortlet project, and select Run on Server from the pop-up menu.

4. The index.jsp page of the project will be displayed in the internal browser.
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5. Click on the Launch push button to start the application.

6. The first page of the Order Entry application is displayed.
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At this point, the application will run the same as it did in the Test Environment. Go ahead and press F4 to prompt for a customer number and exercise the application to see its behavior in the portal environment.

Recap

Congratulations! You have completed Creating the WebFacing Portlet project. You should now understand how to: 

· Launch the WebFacing Portlet project wizard 

· Complete the pages of this wizard in order to create a new WebFacing portlet project called wflabxxPortlet 

· Add to this WebFacing Portlet project the following information: 

· Which DDS display file source members to use for the WebFacing conversion 

· Which UIM panel group source members to convert 

· The CL command which will be used to create the initial index.jsp page to start the Order Entry application 

· The Web style to be used for the resulting Web pages 

· Create a test portal server
· Deploy the WebFacing portlet to the test portal server
· Start the test portal server
· Test the WebFacing portlet in the test portal server
Enabling System Screen support

In this chapter, you will learn how to enable system screen support in a WebFaced application. System screen support enables your application to display a subset of system screens, such as Work with All Spooled Files (WRKSPLF). This support is available only in the advanced version of WebSphere Development Studio Client.

In this chapter, you will convert an existing sample 5250 application that displays the Work with All Spooled Files (WRKSPLF) screen when a command key is pressed. 

In order to accomplish these learning objectives, there are several steps that are involved, including:

· Exercise 15.1: Running the sample 5250 application

· Exercise 15.2: Creating a new WebFacing application with system screen support

· Exercise 15.3: Test the application with system screen support.

The exercises within each chapter must be completed in order. Start with exercise 15.1: Reviewing the 5250 sample application.

Length of time:


This chapter will take approximately 20 minutes to complete.

Exercise 15.1: Reviewing the 5250 sample application

You will need a 5250 emulator on your workstation to start this sample application. The display for this application uses a subfile to display the orders created by the Order Entry application. Pressing F6=Spooled files on this display will invoke the WRKSPLF system command to display the spooled files.

To run the 5250 application:
1. Start a 5250 emulation session.

2. In the User ID field, type your User ID.

3. In the Password field, type your password.

4. On the command line of the 5250 screen, invoke the sample application: CALL WRKORD.

The application will start and display the Order List screen.
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5. Note that this program does not support any operations on the orders listed. It is just used for this example. You can use the page keys to scroll through the orders.
6. Press F6=Spooled files. This causes the program to use QCMDEXC to invoke the WRKSPLF command.
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7. Press F3 to exit the Work with All Spooled Files screen.

8. Press F3=Exit to end the sample application.

In the next exercise, you will create a new WebFacing project and reface this application. During the project creation, you will enable the system screen support.

Exercise 15.2: Creating a new WebFacing project with system screen support

If WebSphere Development Studio Client is not started, start it now and switch to the WebFacing project.

To create a new WebFacing project:
1. In the WebFacing perspective, click File > New > WebFacing Web Project from the workbench menu.
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2. The first page of the WebFacing Web Project wizard will be displayed
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3. In the Project name field, type the project name wrkord. The EAR project field will be updated automatically.

4. In the WebFacing project features section, check the check box labeled Add system screen support. Notice the right side of this section is updated to reflect what this option will do.

5. Click Next.

6. The Select Display File Source Members to Convert panel is displayed.
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7. Click on the Refresh DDS list button to display the library list. If prompted, specify your iSeries User ID and password.


Selecting the DDS source members

To select the DDS members to convert for this example:
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1. Expand library WFLABXX.

2. Expand source member QDDSSRC.

3. Select the member WRKORDFM.

4. Click the [image: image266.png]


 button to add this member to the list of members to convert.

5. Click Next.

6. When the Select UIM Source Members to Convert page is displayed, just click Next.

The Specify CL Commands page is displayed.

Specifying the CL command

Now, you will specify the command to launch the sample application. The command you specify here, is the same command you used when you reviewed the sample application on the 5250 emulator: CALL WRKORD.
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To specify the CL command:

1. In the CL command field, type CALL WRKORD.

2. In the Command label field, type Work with Orders List.

3. Click the Add button.

4. Check the radio button labeled Specify OS/400 signon values.

5. In the User ID field, type your iSeries User ID.

6. In the Password and Confirm password fields, type your iSeries password.

7. Click Next.

Selecting a Web Style

On the next page of the wizard, you select a style for your application.

To select a Web style:
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1. From the list of available styles, select gradient.

2. Click Next.


The Complete WebFacing Project page is displayed.
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1. Select the radio button labeled Yes I want to create the project and proceed with conversion now.

2. Click Finish.

The WebFacing project wizard will continue and create the project. Once the project has been created, the conversion will begin automatically.

Once the project has been created and conversion is finished, the new project will appear in the workbench.

Exercise 15.3: Test the application with system screen support

To test the application:

1. Right-click on the wrkord project in the WebFacing Projects view.
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2. Click on Run on Server on the pop-up menu.

The Server Selection dialog is displayed.
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1. Check the check box labeled Set server as project default (do not prompt) to avoid having this dialog appear each time you run this application.

2. Click the Finish button.

The index.jsp page of the application is displayed.
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Click on the Launch button labeled Work with Orders List.

The display screen for the sample application is displayed.

[image: image273.png]lwrkord Log

clevosval @

o1k wil rders
08/17/04 Order Entry - Order List O

Order entry order list
mEnter 1=Sslect.

gy
WSpooled files

OrderNum Cust Order Date Items
000004012 0001 B-16-2004 002

000003991 0001 7-01-2003 002
000003990 0001 7-01-2003 002
000003988 0001 7-01-2003 002
000003985 0001 7-01-2003 002
000003888 0001 4-15-2003 002
000003887 0001 4-15-2003 002
000003886 0001 4-15-2003 002
000003885 0001 4-15-2003 002
000003884 0001 4-15-2003 002 L
000003878 0001 4-14-2003 002
000003878 0001 4-14-2003 002
000003877 0001 4-14-2003 002
000003876 0001 4-14-2003 002

2

i o e e e e e





Click on the button labeled Spooled files, or press F6.

The Work with All Spooled Files system screen is displayed in the browser.
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To work with a spooled file entry:

1. Use the page up and page down keys on the keyboard to scroll through the list of spooled files.

2. Click on the selection arrow on the Opt list.

3. From the list, click on an option, for example 5=Display.

4. Press Enter or click on the Enter push button.

The Display Spooled File system screen is displayed.
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Recap

Congratulations! You have completed Enabling System Screen support. You should now understand how to:

· Create a WebFacing project for a program with system screen support

· Test the project in the WebSphere Test Environment and verify the system screen support

Note: If the corresponding 5250 system screen panel provides a command line, then the generated Web page will provide a command line as shown in this example. This command line is available to invoke CL commands. In other words, the full capability of the original system screen is available to the end user. The ability to execute commands and access system objects depends on the user profile used invoke the WebFaced application. Also, it will be possible for the user to call another application from the command line. If that application has not been converted by WebFacing, run time errors will occur. 

Supported system screens

This is a list of the currently supported WebFacing system screens:

· WRKACTJOB 

· WRKJOB

· WRKJOBQ

· WRKJRN

· WRKLIB

· WRKMNU

· WRKMSG

· WRKMSGD

· WRKMSGQ

· WRKOBJ

· WRKOBJLCK

· WRKOUTQ

· WRKOUTQD

· WRKPRTSTS

· WRKSBMJOB

· WRKSYSSTS

· WRKUSRJOB

· WRKUSRPRF

· WRKWTR

Invoking a Java Application from a WebFaced Web page

In this chapter, you will learn to invoke a Java program using a hyperlink on a WebFacing Web page. Integrating an IBM WebFacing Tool application with other Java-based applications is a great way to provide new functionality not available in the original RPG application. 

For this example, we have a very simple Java application that does nothing more than display the two arguments passed to it in a new browser window. The arguments passed to the Java application are data fields from the WebFacing application.

In order to accomplish these learning objectives, there are several steps that are involved, including:
· Exercise 16.1: Import and Understand CustomerOrder

· Exercise 16.2: Deploying the Java Application

· Exercise 16.3: Changing the Web Settings to call CustomerOrder.jsp

· Exercise 16.4: Test the integration of Java application with WebFacing

The exercises within each chapter must be completed in order. Start with Exercise 16.1: Import and Understand CustomerOrder.
Length of time:


This chapter will take approximately 20 minutes to complete.

Exercise 16.1: Import and Understand CustomerOrder

First, we need to import the Java application into WebSphere Development Studio Client, and then we can explore the Java application. This application is a dynamic Web application that can be deployed to an application server much like a WebFacing application.  

The goal of this exercise is to demonstrate how a refacecd application might call Java applications. It should become apparent that this example doesn’t do anything useful, but could easily be modified to. DispArgs.java could run a DataBase Query based on the input data, called a Web Service, or a whole host of other valid business functions that could increase the functionality of the WebFacing application.

Before we can examine the CustomerOrder application, we need to import it into WebSphere Development Studio Client. 
.

1. In WebSphere Development Studio Client click File from the menu and select Import. 
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2. Select EAR file from the list, click Next >. 
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3. Browse to the CustomerOrderEar.ear file in the C:\WebFacingLab\JavaApp\CustomerOrderEar.ear directory. Accept the rest of the default and click Finish. 
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4. Switch to the Navigator view of the WebFacing Perspective. You should now see CustomerOrder. This application has three files of interest:

DispArgs.java – Java Servlet called by WebFaced application

ViewBean.java – Java class that stores the arguments passed to DispArgs.java

CustomerOrder.jsp – Java Server Page that displays the results. 
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At this time, review the DispArgs.java, ViewBean.java and CustomerOrder.jsp files. Of most importance to the student is the performTask() method within the DispArgs.java file. Notice within this method, the parameters for Arg1, and Arg2 are retrieved from the request object. The reason for this importance will be apparent later. 
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Exercise 16.2: Deploying the Java Application

Before we make changes to the WebFacing application, make sure the CustomerOrder application has been deployed to the same WebSphere Application Server Test Environment within WebSphere Development Studio Client.  

1. This can be done in the Navigator view of the WebFacing Perspective. Expand your WebSphere v5.1 Test Environment to see what projects are currently associated with it. Right click on your WebSphere v5.1 Test Environment and select Add and remove projects… 
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2. On the Add and Remove Projects pop-up, select CustomerOrderEar, click the Add button, and click Finish. 
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Now when the server is started, the Java application will be installed and ready to run.

3. You can test the application in the Web Perspective by expanding: CustomerOrder > WebContent > jsp, right clicking on CustomerOrder.jsp and selecting Run on Server.
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4. In the Web Browser, you should see the jsp displayed. Do not worry about the null values, they are null because in this test we did not pass any values. 
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Exercise 16.3: Changing the Web Settings to call CustomerOrder.jsp

For this example, we will change the WebFacing application to include a hyperlink of the customer name field that will call the Java Application when clicked, passing in 2 arguments from the screen.

1. From the WebFacing Project view of the WebFacing Perspective. Expand your WFLabxx project WFLabxx > DDS, right click on the DDS source ORDENTD and select Open With > CODE Designer. 
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2. In CODE Designer, click on the SCREEN1 tab and select ORDCTL from the drop down menu. Then click on the Customer name field and finally click on the Web Settings tab. 
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3. In the Web Setting tab, select Create hyperlink from the list and then click the Create hyperlink checkbox. 
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4. Type http://localhost:9080/CustomerOrder/servlet/DispArgs?Arg1= in the URL text box and _blank in the Target text field. 
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5. Earlier, we mentioned the importance of Arg1 and Arg2 in the DisplayArgs.java class file. These parameters are the strings that DisplayArgs.java is looking for to obtain its values. In the Choose a field dropdown box select &{CUSTOMER.value} and click the Insert field value button.

The URL string should look like the following:
http://localhost:9080/CustomerOrder/servlet/DispArgs?Arg1= &{CUSTOMER.value} 
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6. Add &Arg2= to the end of the URL string after the closing }. The URL should then look like: http://localhost:9080/CustomerOrder/servlet/DispArgs?Arg1=&{CUSTOMER.value}&Arg2
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7. In the Chose a field drop down box, select &{PROMPT.ORDNBR.value} and click the Insert field value button. Your URL string should now look like: http://localhost:9080/CustomerOrder/servlet/DispArgs?Arg1=&{CUSTOMER.value}&Arg2&{PROMPT.ORDNBR.value} 
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8. Save the changes in CODE Designer by clicking on File > Save. Then exit CODE Designer.
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9. Now that we have made changes to ORDENTD, it needs to be reconverted. In the WebFacing Perspective, right click on ORDENTD and select Convert. This needs to be done so the files can be generated to call the CustomerOrder application when the customer name hyperlink is clicked.
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Exercise 16.4: Test the integration of the Java application 

Now that we have imported our Java application and modified our DDS source using Web Settings in CODE Designer, we need to test our WebFacing application.

1. In the WebFacing Perspective, right click on your WFLabxx project and select Run on Server. Launch the application, prompt for and select a customer. Run the WebFacing application and select a Customer. Notice on the next screen, the Customer Name field is now a hot link. Placing a cursor over that hot link will display in the status window the URL that will be called upon clicking. 
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2. In this example, the CustomerOrder/serlet/DispArgs servlet will be called and two arguments will be passed, Arg1 and Arg2. Clicking the hot link will call the DispArgs and display the results in a new window. 
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Recap

Congratulations! You have completed Invoking a Java program from the IBM WebFacing Tool. This simple example illustrates a powerful and simple way to provide new functionality in your WebFacing application. You should now understand how to:
· Import an EAR file into WebSphere Development Suite Client
· Deploy an application to the same test server as your WebFacing project

· Change Web Settings to call another program

Invoking an iSeries Program from a WebFaced Web page

In this chapter, you will learn how to invoke an iSeries program from a hyperlink on a WebFaced Web page. The hyperlink will be on a part name field. Clicking the link will invoke an iSeries RPG program, passing it the part number value for this part name. The RPG service program will retrieve the data for this part and display it on another Web page in a separate browser window.

To invoke the RPG service program, you will use the Web Tools Web Interaction feature of WebSphere Development Studio Client. This feature allows you to define input and output pages and then link fields on those pages to parameters of the iSeries host program. The wizard generates all of the code required to map input fields that are contained on the input page to the parameters that will be used as input on the iSeries program. The wizard will also map the output field values from the iSeries program to the fields defined on the output page. As well, the code required to invoke the iSeries program is generated.

In order to accomplish these learning objectives, there are several steps that are involved, including:
· Exercise 17.1: Creating a new Dynamic Web project

· Exercise 17.2: Defining the iSeries information

· Exercise 17.3: Running the Web Interaction wizard

· Exercise 17.4: Test the Web interaction

· Exercise 17.5: Creating a JavaScript hyperlink using the Web Settings

· Exercise 17.6: Creating a new JavaScript function to invoke the Web Interaction

· Exercise 17.7: Test the changed application

The exercises within each chapter must be completed in order. Start with Exercise 17.1: Creating a new Dynamic Web Project when you are ready to begin.

Length of time:


This chapter will take approximately 45 minutes to complete.

Exercise 17.1: Creating a new Dynamic Web Project

To begin, you will create a new Web project that will be used to invoke the iSeries program. You could use the existing WebFacing project, but by creating a separate project, you will make this new function available to any other WebFaced project.

To create a new dynamic Web project:

1. Click File > New > Project on the workbench menu.

2. The New Project dialog is displayed:
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3. In the left pane, select Web.

4. In the right pane, select Dynamic Web Project.

5. Click Next.



6. The initial page of the Dynamic Web project wizard will be displayed.
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7. In the Project name field, type getPartDetail.

8. Select the Configure advanced options check box.

9. Click Next.
10. The J2EE Settings page is displayed.
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11. In the EAR project field, type getPartDetailEAR.

12. Click Next.
13. The Features Page is displayed.
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14. Select the Add Struts support check box.

15. Select the iSeries Web Components Tag Library check box.

16. At this point, you can accept the remaining defaults, so click Finish.
If you are prompted change Perspectives, click OK. Once the project has been created, you will be back in the workbench where you will see your new project in the Project Navigator view of the Web perspective.
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Exercise 17.2: Defining iSeries configuration information
Since this project will be used to invoke an RPG program, you need to define information about the particular iSeries server upon which the program will run, such as: server name and user profile.

To define iSeries configuration information:

1. Right-click on the getPartDetail project in the Navigator view.
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2. Click Specify iSeries Web Tools Run-time Configuration on the pop-up menu.
The iSeries Web Tools Run-time Configuration wizard opens.
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This page of the wizard is used to indicate which iSeries to use as well as how the user is to be authenticated to the system.

3. In the Host name field, type the name of the host system, for example s400a.

4. In the User ID and Password fields, type the appropriate values.

5. Click Next.  

6. The Configure Run Time page is displayed.
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7. Select the check box, Display detailed run-time errors. This will result in a detailed error page being displayed if a run-time error occurs.

8. Click Finish to define the iSeries run-time information for this project.


Exercise 17.3: Running the Web Interaction wizard

You will now use the Web Interaction Wizard feature of WebSphere Development Studio Client. A Web Interaction is the flow from an input page to an action to be performed, then to an output page. In our case, the input page will prompt for a part number, the action to be performed will be an RPG service program procedure and the output page is a Web page with part detail. The wizard handles collecting data from the input page, and passing it as parameters to the service program procedure. When the procedure ends, the output parameters will be mapped to elements on the output page which is then sent to the browser.  

For this chapter, you will not be using an input page, even though one is created by the wizard for us. The input for this interaction will come from a value on a hyperlink in the page created by the IBM WebFacing Tool. However, you will be using the input page to test the Web Interaction.

To run the Web Interaction wizard:
1. Select the getPartDetail project, then click on the Web Interaction Wizard icon on the toolbar:
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2. The first page of the Web Interaction Wizard is displayed.
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3. Type getDetail for the name of this interaction.

4. Ensure the User error page check box is checked.

5. Click Next.
The Specify the Input and Output pages for your Web Interaction is displayed.
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6. Select the radio button labeled Generate input page.
7. Select the radio button labeled Generate output page.
8. Click Next.

Defining the iSeries procedure to invoke

At this point, you have given this interaction a name, and indicated that you want the wizard to generate the input and the output pages. You must now define the information about the RPG procedure to be invoked including the name of the service program and procedure as well as define the parameters for the procedure.

This procedure will have one input parameter, the part number, and one output parameter which will be a structure of fields of part information.

You will begin by first defining the return structure containing the part information.

To define the structure:
1. On the Specify Input and Output Parameters for your iSeries Host Program page of the wizard, click the Add Structure button. The Add Structure panel opens on the right side of the wizard.
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2. Type partDetailStruc in the Structure name field.

3. Click OK to add this structure to the Web Interaction.

4. The structure is added in the Program call definitions section on the left pane, and the Add Parameter pane is automatically displayed on the right side of the wizard page.

[image: image309.png][=i

Specify the Input and Output Parameters for your iSeries Host Program

€ Add Paramater

 Use an iSeries program or procedure

Program call defintions

 Use aJavabean

addprogom.. | acdpwroneter | o

€ i program el

%, partDetaitruc

port PCML,

Synchronize Al

Import Source,

5|5

Add Parameter

——— 2
— Crr—
Sxroronm =
Lengh | —
cant | —
e Crrerr—
bl —

T~ Advanced.

Specify database reference field

Shaw database fielddefintion

Surcroriee.

<Back

e





5. At this point, you could click on the Add Parameter button to add parameters to this structure. However, in our case, the parameters you need are defined in the two physical files, STOCK and ITEM. Therefore, you can use the Specify database reference field feature to define the structure parameters.

6. Click on the Specify button.

7. The Specify Database Reference Field dialog is displayed.

[image: image310.png]@ Specify Database Reference Field

Expand a connection, afiker, a ibrary, a record, and a i, and select a fied

= = T ]

W) 05V lb prodsys s
M Q5vs2. b prodsys Comnheadng|_Jtan
1 s oo s Coam b2 Flr
B QUERSIS b rodrs Data Type Charater
W QGPL b, prodhusr Date or time format
&\ WELAERX b testusr Decils o
CSTHR e -t Defaul vaue

DSTRCT e pf-dta Descripton IemData
EVFEVENT. . pf-cha i code or word

o Lengin s

Nae 10aTA
Nl sloned o
Nurber of chidren 0
Record 1me
Type Feld

/8 Usage 3

e pf Variable length Mo

STOCK Hie.p-cka





8. Expand the connection name (s400a).

9. Expand the *LIBL list by clicking on the plus sign (+).

10. Expand the WFLABXX library. 

11. Expand the ITEM file and then the ITRCD record format to see all of the fields in this format

12. You will be using all of the fields in this format. With the Ctrl key pressed, use the mouse to select the fields as shown in the figure and then press the Add button to add these fields to our structure.


13. You will also need one field from the STOCK file.
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14. Expand the STOCK file and then the STRCD record format until you get to the field list.

15. Using the mouse, select the STQTY field, and click the Add button to add this field to our structure.

16. Click the Close button to return to the Specify the Input and Output Parameters for your iSeries Host Program wizard page. 

17. The wizard page now shows the completed structure in the left pane.
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Defining the procedure and parameters

Now, you can define the RPG procedure to be invoked and its parameters.
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To add the program:
1. Click the Add Program button to define a program.

2. In the Program alias field, type getDetail.

3. In the Program object field, type WTUTIL.

4. In the Library field, type WFLABXX.

5. In the Program type list, select *SRVPGM.

6. In the Entry point field, type getPartDetail.

7. Click OK to add this program definition.

The right pane will switch automatically to the Add Parameter view. You will now add parameters to the procedure you just defined.
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8. In the Parameter name field, type partNumber. This will be the part number passed from the hyperlink.

9. In the Data type list, select character.

10. In the Length field, type 6.

11. In the Usage list, select input.

12. Click OK to add this parameter to the program.
You will now add the structure you previously defined as the second parameter to our procedure.
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13. In the Parameter name field, type detailStruc.

14. From the Data type list, select structure.

15. Ensure that partDetailStruc is selected in the Structure name field.

16. From the Usage list, select output.

17. Click OK to add this structure as the second parameter to the program call definition.
The completed program definition will be displayed in the left pane in the Program call definitions section.
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18. Click Next to define the Input and Output pages for this Web interaction.

Defining the Input and Output pages

So far, you have defined the service program procedure to invoke as well as the input and output parameters. In this section, you will define the content of the Web pages to be generated by the wizard.

Since, as mentioned earlier, you will not be using the input page, except for testing, click Next on the Design the Input Form page of the wizard.
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The Design the Result Form page is displayed.
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1. In the Output parameters section, select detailStruc.IID.

2. Click the Fields tab.

3. Click in the Value column for the Label property, and type Part number.

4. Press Enter.

5. Note that on the Result Form page preview pane, the label on the page has changed from IID to Part number.
Using the preceding steps as a guide, change the label for each of the fields to a more meaningful value. The completed form should look similar to the following:
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To complete the form, let’s change the page heading and its background color.
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1. Click the Page tab.

2. Click in the Value column for the Page Title property and type a new title such as Part Detail.

3. Click on the Value tab of the Background Color property and click the color selection button.

4. When the Color dialog is displayed, click on a color of your choice for the background color and click OK.
5. Click on the Value column of the Title Color property.

6. When the Color dialog is displayed, click on a color of your choice for the title and click OK.

7. Click Finish to complete the Web Interaction Wizard.

Exercise 17.4: Test the Web interaction

At this point, you can test the Web interaction to verify it works before you move on to creating the hyperlink in the WebFaced application to invoke this interaction. To verify the interaction:
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From the Navigator view of the project, expand the project.
1. Expand the WebContent folder.

2. Right-click on the getDetailInput.jsp page and select Run on Server from the pop-up menu.
The Server selection dialog is displayed.
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3. Ensure the WebSphere v5.1 Test Environment server is selected if there is more than one server.

4. Select the Set server as project default (do not prompt) check box.

5. Click Finish.

6. The input page will be displayed, prompting for a part number.
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7. In the partNumber field, type a value of 000001.

8. Click the Submit button.

9. The output page will be displayed showing the part detail:
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Note the Web Interaction URL

Before you leave this section, you need to take note of the URL to invoke this Web Interaction.  This URL will be used later in the JavaScript code that you create.

Each Web Interaction is stored in the project with the name it was given when created, with a .wit extension.

To review the Web Interaction URL:

1. Expand the project and locate the Web interaction file, getDetail.wit.
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2. Right-click on the Interaction file and select Open With > Web Interaction Wizard.

3. The Web Interaction Wizard is displayed.
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4. Note the value of the Interaction URL field.

5. The getDetail.do portion is the name of the generated action.

6. The partNumber=#1 portion describes the part number parameter.

7. The _witreq=1 portion is required when invoking an Interaction from another Web page.

When invoking an Interaction from another project, you must precede it with the context root of the Interaction. In our case, the context root is /getPartDetail.

Therefore, the URL required to invoke this Web Interaction from another Web project would be:

/getPartDetail/getDetail.do?_witreq=1&partNumber=#3

In a URL, the question mark(?) indicates the beginning of the parameters. The ampersand (&) is used to separate parameters. The #3 will be replaced with the actual value of the part number at run-time. The order of the parameters is not important.

Make note of this URL as you will be using it later on in this chapter.

Exercise 17.5: Creating a JavaScript hyperlink using the Web Settings

Now you will return to the WebFacing project and use the Web Settings feature to create the hyperlink to invoke the Web Interaction in the Web Tools project you just created. You will use the Web Settings to create a hyperlink on the part Description output field of the Select part window.
Note: In this sections you may run into an issue where the options are greyed out on the screen. If you do apply the fix detailed below.

CODE Designer Patch for APAR SE19450

Abstract: The Function key and JavaScript function call fields are not enabled when the Action hyperlink radio button is selected in the Create hyperlink WebSettings panel. 

go to: http://www-306.ibm.com/software/awdtools/wdt400/support/

In the Search field, just type 'SE19450' and click Submit, then follow the directions
To create the hyperlink:

1. In the WebFacing project view, expand the wflabxx project and its DDS folder.  

2. Right-click on the SLTPARTD source member.

3. Click Open With > CODE Designer on the pop-up menu.
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The DDS member is loaded and CODE Designer opens.
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1. Select the PARTSFL tab on the notebook.

2. Click on the first row of the Description field and select the Web Settings tab.

3. In the left pane, select the Create hyperlink option.

4. In the right pane, select the Create hyperlink checkbox.

5. In the right pane, select the JavaScript hyperlink radio button.

6. In the entry field, type the following text: showPartDetail(&{IID.initialValue})

7. Save the DDS by selecting File > Save.


With this Web Setting, a hyperlink will be created around the part Description output field in the part subfile. Clicking this hyperlink will invoke the JavaScript function showPartDetail. The value passed to this JavaScript function will be the value of the part number field (IID). Note that the values in this field are case sensitive and must be typed as shown.

Now, you must create the JavaScript function in the WebFaced project. This JavaScript function will in turn, invoke the Web Interaction you created earlier.

Exercise 17.6: Creating a JavaScript function to invoke the Web Interaction

In this part of the exercise, you will create the JavaScript function to invoke the Web Interaction. Each WebFacing project has a folder named usr in the WebContent folder. Any JavaScript in this folder will be sent to the browser each time a WebFaced page is to be displayed. You will create a JavaScript file in this folder, and type the JavaScript function in the file.

To create the JavaScript file:

1. Switch to the Navigator view in the WebFacing project.

2. Expand the WebContent folder until you get to the usr folder.
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3. Right-click the usr folder, and from the pop-up menu, select New > Other.
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4. On the Select page, select Web in the left pane and JavaScript File in the right pane.

5. Click Next.
6. The New JavaScript File page is displayed.
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7. On the New JavaScript File page, type a name for the new JavaScript file, such as usrFunctions.js.

8. Click Finish.
9. When the new JavaScript file opens in the editor, delete the generated text and type the new JavaScript function.
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10. Press Ctrl+s to save the new JavaScript file.

Here is an overview of this JavaScript function:
· Line 2 declares the function and indicates it is receiving a single parameter.

· Line 4 defines a variable that determines the features of the pop-up window including its size and the fact it has no toolbar.

· Line 5 defines the URL that will be loaded into the pop-up window. Notice that this is the URL you noted earlier in the Web Interaction section of this chapter. Also, note at the end of the URL, you are appending the value of the passed in part number.

· Line 6 creates the pop-up window which causes it to display the results of the Web Interaction.

· Line 7 is used to give the window focus in case it does not appear in the foreground.

Exercise 17.7: Testing the changed application

Before you can test the new function, you must convert the WebFacing project to pick up the new Web Settings you just added

To convert the project:

1. Select the WebFacing Projects tab to switch to the WebFacing Project view

2. The WebFacing Project view is displayed
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3. Right-click on the project and select Convert from the pop-up menu.

4. Wait until the conversion is complete, and the conversion log is displayed.

Restart the test server

In addition, whenever changes are made to the JavaScript, you must re-start the application in the test environment server. (Note: this is not required on the production server.)

To re-start the application:
1. Switch to the Server view. This view is usually located in the lower right corner of the workbench.
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2. Right-click on the Test environment server and select Restart Project.

3. From the cascading menu, select your WebFaced project.

4. Wait until the message appears in the Console view indicating your application has started.

5. In the WebFacing Projects view, right-click on the project and select Run on Server.

6. As you have done before, select a customer number to get to the Parts Order Entry screen.
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7. Press F4 to open the Select Part window.

8. Note that the part Description output fields of the subfile are now hyperlinks.

9. Click on one of the hyperlinks.

10. The part detail, as retrieved by the Web Interaction, will be displayed in a pop-up window.

Note: You will notice that when the pop-up window appears, it will be larger than the size that was defined in the JavaScript. This is due to the behavior of the built-in Web browser. To see how the pop-up will appear to an end user:
1. Start a new instance of Internet Explorer.

2. Copy the URL address from the location field of the internal browser.

3. Paste the URL into the location field of the new browser window.

4. Press Enter to invoke the WebFaced application.

Now, when you run the application, the pop-up window should appear in the size defined by the JavaScript function.

Recap

Congratulations! You have completed Invoking an iSeries program from a WebFaced application. You should now understand how to:
· Use the Web Interaction wizard to invoke an iSeries program
· Test the Web Interaction
· Add a JavaScript hyperlink using Web Settings
· Add a JavaScript function to a WebFaced application.

· Restart a Web project

· Test the application by clicking on one of the hyperlinks

Adding a pop-up calendar

In this chapter, you will learn how to incorporate a pop-up calendar in a WebFaced page. Pop-up calendars are very useful in a graphical interface in that they allow the user to simply click on a date value and have it inserted into the target field. This usually results in fewer typing errors by the end user as well as making the application easier to use.

Before you begin this chapter, you must have completed Chapter 15 - Enabling system screens. This chapter will enhance the project created by that chapter by adding a pop-up calendar.

In order to accomplish these learning objectives, there are several steps that are involved, including:

· Exercise 18.1: Reviewing the sample 5250 application

· Exercise 18.2: Importing the calendar JavaScript and style sheet

· Exercise 18.3: Adding the Web Settings to invoke the calendar pop-up

· Exercise 18.4: Convert the project with the new Web Settings

· Exercise 18.5: Test the application with the JavaScript calendar.

The exercises within each chapter must be completed in order. Start with exercise 18.1: Reviewing the sample 5250 application.

Length of time:


This chapter will take approximately 30 minutes to complete.

Exercise 18.1: Reviewing the 5250 sample application

You will need a 5250 emulator on your workstation to start this sample application. The display for this application uses a subfile to display the orders created by the Order Entry application. Selecting option 2 on an order will display a window that allows you to change the order date for an order.

 To run the 5250 application:
1. Start a 5250 emulation session.

2. In the User ID field, type your User ID.

3. In the Password field, type your password.

4. On the command line of the 5250 screen, invoke the sample application: CALL WRKORD.

The application will start and display the Order List screen.

[image: image336.png]8/27/04

Entry - Order List TORASLP3

Order entry order list
2=Change date

Opt Order Num Cust Order Date Items
000004012 0001  8-16-2004 002

@ 000003991 0001  7-01-2003 002
000003990 0001  7-01-2003 002
000003988 0001  7-01-2003 002
000003985 0001  7-01-2003 002
000003888 0001 4-15-2003 002
000003887 0001  4-15-2003 002
000003886 0001  4-15-2003 002
000003885 0001 4-15-2003 002
000003884 0001 4-15-2003 002
000003879 0001  4-14-2003 002
000003878 0001  4-14-2003 002
000003877 0001 4-14-2003 002
000003876 0001  4-14-2003 002

More. ..
Fa=Exit F6=Spooled files

©9/003







5. You can use the page keys to scroll through the orders.

6. In the option field for one of the orders, type a 2, and press Enter.

7. Another screen is displayed prompting for a new date for this order.
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8. Type a new date in the Date field and press Enter.

9. The date is updated in the selected subfile record.

10. Press F3=Exit to end the sample application.

In the next exercise, you will import some JavaScript files as well as a style sheet that will display a pop-up calendar from which the user can select a date on the Change Order Date screen on the refaced version of this sample application.

Exercise 18.2: Importing the calendar JavaScript

In this exercise, you will import the JavaScript files and style sheet required to display a pop-up calendar.

There are many JavaScript calendars available on the Internet. For this exercise you will use one that was downloaded from: http://www.hotscripts.com/JavaScript. On that page, click on Scripts and Programs, then Calendars which will take you to a page with many JavaScript calendars. The one used in this exercise is JS calendar version 9.6.  

To import the JavaScript files:
1. Switch to the Navigator view for the wrkord project
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2. Expand WebContent > webfacing > ClientScript > usr.

3. Select the usr folder.

4. Right-click on the usr folder and from the pop-up menu, select Import.

5. The Select page of the Import wizard is displayed.
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6. Select File system and click Next.

7. The File system page is displayed.
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8. Click the Browse button next to the From directory field

The Import from directory dialog will open.
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9. On the Import from directory dialog, expand down to the C:\WebFacingLab\Calendar folder.

10. Click on the Calendar folder, and click OK.

11. The File system dialog is displayed with the selected folder.
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12. In the left pane, select the Calendar folder.

13. In the right pane, check the check boxes for the files calendar.js, dcalendar-setup.js, ecalendar-en.js and mycalendar.js. Make sure the other check boxes are un-checked.

14. Ensure the Into folder field contains the path to the usr folder in the wrkord project.

15. Click Finish to import the files.

16. The Navigator view now shows the imported files in the usr folder.
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Importing the calendar style sheet

You need to import one more file into our project. This one is a Style Sheet that defines the look of the calendar. This style sheet must be imported into the styles folder of the project. In addition, a reference to the style sheet must be added to the PageBuilder.jsp JavaServer page.

To import the style sheet:
1. Ensure you are in the Navigator view.
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2. Expand the WebContent > webfacing > styles > chrome folders.

3. Right-click on the chrome folder, and select Import from the pop-up menu.

4. The Select page is displayed.
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5. Select File system and click Next.

6. The File system page is displayed.
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7. Click the Browse button.

8. The Import from directory dialog is displayed.
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9. Expand down to the C:\WebFacingLab\Calendar folder.

10. Click OK.

11. The File system page is displayed with the selected folder.
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12. In the right pane, check the check box for the calendar-win2k-1.css file.

13. Click Finish to import the style sheet.

14. The Navigator view is shown with the imported style sheet.
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Adding a reference to the style sheet to PageBuilder.jsp

To use a style sheet, a link to it must be made in a JSP. Since PageBuilder.jsp is sent to the browser after each request, you will put the link to the style sheet in that page.

To put the style sheet link in PageBuilder.jsp
1. Ensure you are in the Navigator view.
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2. Expand WebContent > webfacing > styles > chrome > html.
3. Double click on PageBuilder.jsp.

4. Page designer will open with PageBuilder.jsp.
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5. Ensure the Source tab is selected.

6. Insert the following statement before the </head> tag:
<link rel=”stylesheet” type=”text/css” href=”styles/chrome/calendar-win2k-1.css” media=”all”>

7. Press Ctrl+s to save your changes.
Exercise 18.3: Adding the Web Settings to invoke the calendar pop-up
As mentioned, you will be adding the pop-up calendar to the previously created project wrkord. To invoke the pop-up calendar, you will be adding a hyperlink to a Web page using the Web Settings feature of the IBM WebFacing Tool.

To add the Web Settings
1. Ensure you are in the WebFacing perspective.
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2. Click on the WebFacing Projects tab to switch to the WebFacing Projects view.

3. Expand the wrkord > DDS folders.
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4. Right-click on the WRKORDFM member.

5. Select Open With > CODE Designer from the pop-up menu. If prompted, specify your User ID and password.

6. CODE designer opens with the selected member and the Group properties dialog is displayed:
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7. Select CHGDATE in the Available list, and click the [image: image355.png]


 button to move this format to the Selected list.

8. Click the X (at the top of the browser) to close the Group properties dialog.

9. The selected format, CHGDATE is displayed in CODE Designer
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10. Select the MMDDYYY constant.

11. Click the Web Settings tab.

12. In the left pane, select Create hyperlink.

13. In the right pane, select the check box Create hyperlink.

14. Also, in the right pane, select the radio button labeled JavaScript hyperlink.

15. In the entry field type: 
showCalendar(‘l<%=zOrder%>_CHGDATE$NEWDATE’, ‘%m%d%Y’)
(Note: the ‘l’ is a lower case L. Type this data exactly as shown.)

16. Click the save icon [image: image357.png]


 in the tool bar to save your changes.

17. Close CODE Designer.

Exercise 18.4: Convert the project with the new Web Settings

To pick up the all of the changes made to the project, it must be converted again.

To convert the project:

1. Ensure you are in the WebFacing Projects view.
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2. Expand the wrkord > DDS folders.

3. Right-click on the WRKORDFM DDS member.

4. Select Convert from the pop-up menu.

5. The project will be converted.

Exercise 18.5: Test the application with the JavaScript calendar

Now, you can test the project to see how the pop-up calendar works.

To test the project:
1. Ensure you are in the WebFacing Projects view.
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2. Right-click on the wrkord project and select Run on Server from the pop-up menu.

3. When the index.jsp is displayed in the internal browser, click on the Launch push button.

4. The first screen of the application is displayed.
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5. Type 2 in any of the Opt fields and click the Enter button, or press Enter.

6. The Change Order Date display is shown:
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7. Notice the MMDDYYYY constant is now a hyperlink.

8. Click on the hyperlink.

9. The pop-up calendar is displayed.
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10. Click on a day in the calendar.

11. The new date is now in the Date field.
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12. Press Enter to return to the first screen with the updated date.

Recap

Congratulations! You have completed Adding a pop-up calendar. You should now understand how to:

· Add additional JavaScript to your WebFacing project
· Add additional style sheets to your WebFacing project
· Reference style sheets in your WebFacing project

· Add Web Settings to invoke the JavaScript

· Test the project to verify the added files work as expected
As mentioned, there are many other JavaScript calendars on the Internet that can be used for this purpose. With an intermediate level of understanding of JavaScript you could create your own customized JavaScript pop-up calendar.

There are many ways of invoking the pop-up calendar. In this exercise, you created a hyperlink for a constant field that invoked the JavaScript function. You could also have created a graphic next the Date field that when clicked would invoke the JavaScript function. Another possibility, if there is limited room on the screen, is to allow the user to double-click in the Date field to invoke the pop-up calendar.

Advanced Web Settings Example

To further enhance the results of the IBM WebFacing Tool, you will need to understand the JSPs that are created for each record format that you have converted. These JSPs simply represent and use the same data and field names that are in your original DDS source. Understanding these JSPs gives you the power to greatly enhance the user interface of your WebFacing application. There are two ways to make changes to your WebFacing application, you can use Web Settings or you can directly edit the generated JSPs. Customizations made using Web Settings are saved as comments in your DDS and are automatically regenerated during future conversions. You can also edit JSP files directly using the powerful HTML, Java, and JavaScript editing features of the Page Designer tool. However, changes made in this way are lost on re-conversion unless you save your edits and manually reinsert them after re-conversion. It is also possible to save these direct edits in a Web Setting and not lose the changes on re-conversion. This last approach gives you benefits of both Page Designer and Web Settings. 

In this chapter, you will learn how to change the user interface of your WebFacing application by directly editing JSPs using Page Designer. You will add JavaScript to a JSP so that subfile rows change color when the mouse moves over them. You will then learn how to save this modification using Web Settings in CODE Designer so that your changes are saved when you reconvert the DDS member. 

In order to accomplish these learning objects, there are several steps that are involved, including: 

· Exercise 19.1: Understanding and editing JSPs using Page Designer

· Exercise 19.2: Change the color of a subfile row example using Page Designer

· Exercise 19.3: Using Web Settings to save your edits for re-conversion

The exercises within each chapter must be completed in order. Start with Exercise 19.1: Understanding and editing JSPs using Page Designer.

Length of time: 

This chapter will take approximately 40 minutes to complete.

Exercise 19.1: Understanding and editing JSPs using Page Designer

In this exercise, you will use WebSphere Development Studio Client to edit JSPs using Page Designer and add Web Settings using CODE Designer. If WebSphere Development Studio Client is not running, start it now. 
Ensure you are in the WebFacing perspective with your project, and you are in the WebFacing Projects view.

Select record JSP to edit using Page Designer

To open the JSP source file using Page Designer: 

1. Select the WebFacing project you have been working on in the previous chapter, wflabxx. 

2. Expand this project by clicking the plus sign (+) beside its icon in the WebFacing Projects view. 

[image: image364.png]50 wiabiox
Gl L Commands
@ans
G <54003>WFLABKKIQDDSSRC(ORDENTD)

Gy <54003> WFLABXK]QDDSSRC(SLTCUSTD)
G <54003> WFLABXK]QDDSSRCSLTPARTD)
9 Uibep
G <s400a>WFLABKH]QPHLSRC(ORDENTRPIL)
55 sk
85 gradient
B indexcisp
B} logon.isp

Webradig Profects [Nevigtor servr Cofiguatn





You should see a DDS folder in the expanded view. 

3. Expand the ORDENTD DDS file and then the ORDCTL record format by clicking the plus sign (+) beside their icons. Now right-click the ORDCTL.jsp file and click Open With and Page Designer on the pop-up menu. The Page Designer tool should open the ORDCTL.jsp file.
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Understanding the fields in the JSP source

To look at the JSP source you must: 

1. Make sure that the Page Designer tool is already open with the source tab selected. Find an example of a named field with an ID equal to: id='l<%=zOrder%>_ORDCTL$CUSTOMER' in the JSP source. Note that the Design and preview tabs for this JSP are not very usable. This is because the code in the JSP is quite complex and is not meant to be displayed on its own. The JSP is included at runtime by PageBuilder.jsp to make up the Web page which can be made up of several records formats just like your 5250 screens.
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2. Look through the source of the JSP. You will see HTML tags like <span>, Java code also called scriptlets surrounded by <% %>, and JavaScript function calls like this:
onClick="<wf:js function="setCursor"/>(7, 2,null,'<%=(String)session.getAttribute("UniqueId")%>');"  

The above is an example of how one of the WebFacing JavaScript functions is called. The setCursor JavaScript function is placed on the onClick HTML attribute to set the cursor on a field when the field is clicked on. A custom tag is used to call the JavaScript function and pass a parameter to it that includes some Java code. This is a WebFacing custom tag which will prefix c_i_e_i_w_versionNumber (e.g. c_i_e_i_w_5121) to the setCursor JavaScript function name. This allows the JavaScript function to have a unique name, which is required in order to run more than one WebFacing portlet in the WebSphere Portal environment. Normally, simple JavaScript is surrounded by <SCRIPT language='JavaScript1.3'> </SCRIPT> tags. You do not need to understand every detail in the JSP, just learn to recognize the different types of tags and find out where the fields are. In the next three steps you will try to find the source in the JSP for different types of fields and compare it with the DDS source.

3. This is an example of an ORDCTL record format text constant:

JSP source: <span id='l<%=zOrder%>_ORDCTL$Unnamed0' 

DDS source: A              7  2'Customer name . . . . . . . :'  
<%=zOrder%> is a variable used at runtime to identify the layer number that your record format is in. Since we do not know how the iSeries program will write this record format, the layer number could be different when this record format is used on different screens. The layer number is followed by _recordformatname$ and then the text constant is called Unnamed0, since text constants are not named fields in the DDS. 
4. This is an example of an ORDSFL subfile output field in the ORDCTL JSP. This JSP includes fields and data from the subfile control record ORDCTL, but also includes fields and data from the subfile record ORDSFL and names them with the ORDCTL name rather than the ORDSFL name. This is because only one JSP is generated on conversion for a subfile control record and its corresponding subfile record.

JSP source: <span…id='l<%=zOrder%>_ORDCTL$PARTNBR__O$<%=rrn%>'
DDS source: A    PARTNBR_O R    O 14  6REFFLD(IID *LIBL/ITEM)
The <span HTML tag starts the output field. It is followed by some attributes that you do not need to worry about (they are replaced with …) but if you find the ID, you will find it has a similar name to the original DDS field name, but has an extra underscore character. The field name PARTNBR_O is converted to PARTNBR__O. This is an example of how special characters are treated when converting from the DDS field name to the HTML ID.  

· Upper case A-Z and 0-9: has no transform

· '_' becomes "__"

· '@'becomes "_x"

· '#'becomes "_y"

· '$'becomes "_z"

Other special characters valid in DDS field, record or file names become something like "_" + four digit alphabetic characters that represent the hex value for that special character.

<%=rrn%> is a variable used to identify the subfile relative record number for each subfile row.
5. This is an example of an input-capable field from the ORDSFL subfile record format that you should be able to find in the ORDCTL.jsp source:

JSP source: <INPUT…id="l<%=zOrder%>_ORDCTL$OPT$<%=rrn%>">
DDS source: A            OPT            1Y 0B 14  3EDTCDE(Z)   
Here the <INPUT HTML tag starts the input capable field.
Exercise 19.2: Change the color of a subfile row example using Page Designer

In this example you will see how direct edits to a JSP can be used to quickly try new code in your record formats. You will add JavaScript to a JSP so that subfile rows change color when the mouse moves over them.

Adding JavaScript to the JSP source

To edit the JSP source: (Please note: the "example" JavaScript used in the example may not work with all PCs and Browsers and may fail.)
1. Go to the Page Designer tool that has the ORDCTL.jsp file you were working with in the previous exercise. 

2. Find the OPT subfile input-capable field in the ORDCTL.jsp source. It should look something like this:

JSP source: <INPUT…id="l<%=zOrder%>_ORDCTL$OPT$<%=rrn%>">
3. Place your cursor just before the HTML <INPUT tag and copy and paste in the following JavaScript code:

<% if (!isProtected) { %>

<SCRIPT language='JavaScript1.3'>
//alert(l<%=zOrder%>r<%=currentRow%>);
//var currentRowObject = l<%=zOrder%>r<%=currentRow%>;
var currentRowObject = document.forms("<%=(String) session.getAttribute("UniqueId")%>").all("l<%=zOrder%>r<%=currentRow%>");
currentRowObject.onmouseover = colorFunction;
currentRowObject.onmouseout = returnColorFunction;

</SCRIPT>

<% } %>

The first and last line will allow the JavaScript code to only be included when the subfile is in an active layer. For example, when you prompt and a Window record appears, the subfile should not be active. The second and second to last line will start and end your JavaScript code. The third line is an alert statement that is commented out with //. If you remove the comment tags you can use this type of alert statement to debug your JavaScript. The next line shows you how you would set the variable currentRowObject to select the row in the subfile that you want to change the color of. That line is commented out to show you what you would normally do to get the row object. However, in order to enable this application for both Web and Portal environments we use the currentRowObject as defined in the fifth line. In the portal environment, if you have two WebFacing portlets running, there may be more than one row with the same ID. In order to reference the correct object, the unique form ID is used to retrieve the ID within that form. This way it will work for both Portal and Web environments. The next two lines are calls to the two functions that we will define in the next section Adding a User Defined JavaScript File to your Project.  

Notice that the Java variables <%=zOrder%> and <%=currentRow%> are used to build the above JavaScript. The Java for loop in the subfile section of the JSP creates a different copy of the JavaScript code for each subfile row. 
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To view the compiled output and see your resulting JavaScript, you need to run the application on the Web. You can do this when running the application in one of the following sections of this example by viewing the HTML source when the ORDCTL record format is displayed on the Browser.

Adding a User Defined JavaScript File to your Project

To edit the JSP source:

1. Click the Navigator tab to switch to the Navigator view. 
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2. Locate the usr folder in the WebFacing project. It is located in the following directory hierarchy: wflabxx\WebContent\webfacing\ClientScript\
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3. Right-click the usr folder icon in the Navigator view and click New > Other on the pop-up menu. 

4. The New dialog appears.
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5. To create a new JavaScript file, click Web and then JavaScript File in the New dialog and click Next.
6. Enter a name for your new JavaScript file. It does not matter what name you use, but for example, you can use subfilerowcolor as the name. Click Finish. 
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A JavaScript file will be created with the extension .js in the usr folder. This file will be automatically included when you run your WebFacing project.  

NOTE: You need to restart the application server or the application when you add a new JavaScript file. In addition, if you modify the user defined JavaScript file, you may need to clear the files saved in your browser to get the changes to take effect. To do this in your Web browser select File > Tools > Internet Options… and in the General tab under Temporary Internet files select Delete Files.
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Now select OK in the next dialog that appears.
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7. In the editor that appears for the subfilerowcolor.js file, enter the following JavaScript code. This will define the JavaScript functions that you are calling in the ORDCTL.jsp.  
// subfilerowcolor.js
// newFunction
var line     = null;
function colorFunction(){
//      alert(window.event.srcElement.parentElement.tagName);
      if (window.event.srcElement.parentElement.tagName == "TR"){
         line = window.event.srcElement.parentElement;
      }
      line.oldStyle = line.style.backgroundColor;
      line.style.backgroundColor = '#9999ff';
}
function returnColorFunction(){
      if (window.event.srcElement.parentElement.tagName == "TR"){
         line = window.event.srcElement.parentElement;
      }
      if (line.oldStyle != null){
         line.style.backgroundColor = line.oldStyle;
      }
}

The first function colorFunction is called when a mouse over event is triggered on a particular subfile row. This will change the color of the subfile row to '#9999ff' (which is blue) when the mouse is placed over the row. 
The second function returnColorFunction is called when a mouse out event is triggered on a particular subfile row. This function uses the JavaScript variables line and oldStyle to change the row color back to its original color when the mouse is moved away from the row.  

You may wonder at this point why we would not just put these color changes on the table row tag directly. This is because you do not have access to the output of the table row on conversion of your DDS record formats. So in order to save the information for future conversion, all modifications should be done in Web Settings and Web Settings modifications can only be done on fields or field tags like the <span> and <input> tags or before and after fields. This is why we manipulate the TR attributes indirectly using JavaScript.

Running the WebFacing application for this subfile example

Follow these steps to view the subfile that you have been working with in this example:

1. Right-click the wflabxx project icon in the WebFacing Projects view. 

2. Click Run on Server on the pop-up menu. 

3. Go to the browser pane and click the Launch link. 

You will see the first screen of your application. Nothing has changed there. 

4. Click the Prompt push button, or press command key F4. 
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5. Select a customer from the list by clicking on the link. 

6. Press command key F4 to see a list of available parts. 

7. The Select Part panel opens. 
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8. In the Options field, type 1 next to a part that has lots of quantity left and press Enter. 

9. Back on the order screen, the part appears in the order; on the top line of the parts list. 
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Next, you order a certain quantity of this part. 

10. Change the Qty field to a value, for example “2.” 

11. Press the Enter key to add the part and quantity ordered to the order. 

The detail order line for this part, with the quantity specified, is now part of this order. 
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Add more parts until your order is complete. 

12. Press command key F4 to see a list of available parts. 

13. Select a part from the parts list and press Enter. 

14. Specify the part quantity and press Enter.

15. Now move the mouse over one of the parts in your order.  

You will see that each row is highlighted when the mouse passes over it and returns to its original color when the mouse leaves the row. 
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16. Go back to the JavaScript editor of the subfilerowcolor.js file. 
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17. Change the hex value #9999ff to a different hex value like #66ff66. You can use the Colors tab under the source page to find the color that you want. 
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18. Go back to the browser pane and press Enter, you should see the new color being used when the mouse goes over the subfile rows. 
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Exercise 19.3: Using Web Settings to save your edits for re-conversion

In this exercise, you will see how you can save the same code using Web Settings that you entered by directly editing a JSP. This ensures that you do not lose your changes on re-conversion. 

Adding JavaScript using Web Settings in CODE Designer

To start CODE Designer: 

1. Expand the DDS folder. 

2. Right-click ORDENTD source member inside the DDS folder. 

3. Click Open With > CODE Designer on the pop-up menu. 
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CODE Designer loads the DDS member. This takes a moment. 

The DDS member loaded and CODE Designer opens. 
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4. Select the SCREEN1 tab on the notebook if it is not already selected. Also double click on the SCREEN1 icon on the left to make sure that the ORDCTL and ORDSFL record formats are selected for SCREEN1. 
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5. Expand SCREEN1 and the ORDSFL record format by clicking the plus sign (+) beside their icons. Then select the OPT field.   
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6. Locate the Web Settings tab and click on it. 
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7. On the Web Settings page, locate the list that shows the different Web Settings available for the OPT field. 
8. If not all Web Settings show, scroll down to the bottom of the list. Click Insert HTML in the Web Settings list. 
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9. Select the Before tab to the right of the list. 

10. Enter the JavaScript that you previously entered directly into the ORDCTL.jsp into the text area. 

<% if (!isProtected) { %>

<SCRIPT language='JavaScript1.3'>
//alert(l<%=zOrder%>r<%=currentRow%>);
//var currentRowObject = l<%=zOrder%>r<%=currentRow%>;
var currentRowObject = document.forms("<%=(String) session.getAttribute("UniqueId")%>").all("l<%=zOrder%>r<%=currentRow%>");
currentRowObject.onmouseover = colorFunction;
currentRowObject.onmouseout = returnColorFunction;

</SCRIPT>

<% } %>

Just to recap, you specified the following when the application is converted with the IBM WebFacing Tool; the JavaScript will be inserted before the HTML <INPUT tag for the OPT field. Now this setting has been saved for re-conversion. Remember that even though this field is in the ORDSFL record, only one JSP is generated on conversion for a subfile control record and its corresponding subfile record.

11. You can now reconvert the ORDENTD source member and test your application again using the steps in the previous section titled Running the WebFacing application for this subfile example.  
Recap

Congratulations! You have completed Changing the user interface using Page Designer and saving your changes for re-conversion using CODE Designer. You should now understand how to: 

· Edit a converted record format JSP using Page Designer

· Understand the field names as they relate to your DDS source in the converted JSPs

· Change the Web user interface by directly editing a JSP by adding JavaScript to it

· Test the changed application 

· Save the changes for re-conversion using CODE Designer

· Reconvert the application and test the changes again

Note: The green-screen user interface has not changed if the application is invoked as a green-screen application. It will look like the original user interface. The Web Settings apply only to the WebFacing user interface. 

Configuring the WebFacing server

In this chapter, you will learn how to use the WebFacing server configuration Data Area to configure the WebFacing server for up to 16 interactive subsystems.  

It is desirable to configure multiple interactive subsystems if your WebFaced applications are being accessed by a large number of users. Using multiple interactive subsystems improves the scalability of WebFacing by load balancing WebFacing application jobs so that they are spread optimally among the configured subsystems. 

In order to accomplish these learning objectives, there are several steps that are involved, including: 

· Exercise 20.1: Creating additional subsystems

· Exercise 20.2: Adding workstation entries

· Exercise 20.3: Changing the WebFacing server configuration 

· Exercise 20.4: Testing the configuration 
You will need a 5250 emulator on your workstation to carry out the above exercises.

Length of time: 
This chapter will take approximately 45 minutes to complete.

Exercise 20.1: Creating additional subsystems

You will now create additional interactive subsystems. You will model these subsystems after the QINTER subsystem. Before proceeding with the creation of the subsystems, you will need to modify the QINTER subsystem so that it does not intercept WebFacing job requests. 

1. To prevent the QINTER subsystem from handling WebFacing application jobs, you need to modify the subsystem to remove the *ALL work station entry and replace it with the with the display device name convention used for your system. For example, some systems use QPADEV*.

In your 5250 emulator session, issue the iSeries command RMVWSE and press F4 to prompt for the required parameters. Enter the parameters as shown below:
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Now add the generic device names used by your company. To do this, issue the iSeries command ADDWSE and press F4 to prompt for the required parameters. Enter the parameters as shown below, replacing QPADEV* with your generic device names. 
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You need to restart the QINTER subsystem for these changes to take effect. Before restarting the subsystem, you need to ensure that the interactive job from which the subsystem commands will be issued is running under a subsystem other than QINTER. You can transfer the current job from QINTER to another subsystem, for example QBASE, by issuing the following command: 
TFRJOB JOBQ(QBASE)
Once your current job is running under QBASE, you can issue the following commands to restart the QINTER subsystem: 

ENDSBS SBSD(QSYS/QINTER)
STRSBS SBSD(QSYS/QINTER)
2. You will now create 2 interactive subsystems for handling WebFacing application jobs. The subsystems that you create can be modeled after the QINTER subsystem. To do this, you can copy the QINTER subsystem description and remove the 5250 generic workstation names QPADEV* and *CONS.

a. To copy the QINTER subsystem description, issue the CRTDUPOBJ command and press F4 to create a subsystem description with the name WFSBS0 based on subsystem QINTER in QSYS.
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b. Remove the workstation entries *CONS, and QPADEV* from the subsystem using the RMVWSE command as described earlier. 

c. Repeat steps a and b for subsystem WFSBS1. 

Exercise 20.2: Adding Workstation entries for WebFacing

In this part of the exercise you will add workstation entries to the subsystems created in exercise 20.1 to handle the WebFacing application jobs.

WebFacing application job names follow the generic pattern QQF0* when no WebFacing specific subsystem has been configured. In this example, you will configure the WebFacing server for two dedicated subsystems. The WebFacing server will then generate application job names that follow the generic patterns QQF0* and QQF1*. The assigning of application job naming is in accordance with the pattern QQFN*, where N is the number in hexadecimal format, of configured subsystems minus one.

To add workstation entries to subsystem WFSBS0, issue the command ADDWSE as follows:
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Repeat the above step for subsystem WFSBS1:
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You now need to configure the WebFacing server to generate WebFacing job names according to generic names QQF0* and QQF1*.

Exercise 20.3: Changing the WebFacing server configuration

In this exercise, you will configure the WebFacing server to create jobs that can be assigned to the two subsystems just created. 

The WebFacing server uses a Data Area to store its configuration data. Issuing the following command displays the configuration data area:

DSPDTAARA DTAARA(QQFTEMP/QQFCONFIG)
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By default, the WebFacing server is configured for 1 subsystem. To change the number of subsystems to 2, issue the following command:
CHGDTAARA DTAARA(QQFTEMP/QQFCONFIG) VALUE(‘SBS=02;’)
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Here is a recap of what you have accomplished so far: 
· The preceding configuration of the subsystems and WebFacing server will cause the system to deliver WebFacing application jobs to the two subsystems. 
· The WebFacing server will generate application job names alternating between QQF0* and QQF1*. These jobs will be assigned to subsystems WFSBS0 and WFSBS1 respectively. 

In a similar way, you can create more subsystems and assign the appropriate workstation entries to them, and configure the WebFacing server to control the generic naming pattern that the WebFacing server uses. This capability allows you to control the spread of WebFacing application jobs across multiple subsystems. The WebFacing server can support a maximum of 16 subsystems, allowing application jobs of the following names to be created: QQFN* where N = 0 to F.  

You will now proceed to test the new configuration. 

Exercise 20.4: Testing the configuration
To activate the new configuration, you need to:
1. End the WebFacing server

2. Start the new subsystems

3. Restart the WebFacing server

To end the server, issue the following command:

ENDTCPSVR *WEBFACING

To start the new subsystems, issue the following commands:

STRSBS SBSD(WFLABXX/WFSBS0)

STRSBS SBSD(WFLABXX/WFSBS1)

To restart the server issue the following commands:

STRTCPSVR *WEBFACING

You can now invoke multiple sessions of a WebFaced application from multiple browser instances and you will observe the spread of the WebFacing application jobs across the subsystems.

To observe the subsystems, issue the following command:

WRKACTJOB SBS(WFSBS0 WFSBS1)

The WebFacing jobs QQF0* and QQF1* are assigned to subsystems WFSBS0 and WFSBS1 respectively.

Recap

Congratulations! You have completed Configuring the WebFacing server. You should now understand how to: 

· Create additional subsystems dedicated to WebFacing application jobs

· Change the WebFacing server configuration Data Area to control the generic name patterns used by the WebFacing server when generating WebFacing application job names

· Control the spread of WebFacing application jobs across multiple dedicated subsystems

Controlling the spread of the jobs across subsystems allows you to tune the performance and scalability of the WebFacing server depending on the number of concurrent clients accessing WebFaced applications on the target system. 

Tutorial Summary

As you can see with the IBM WebFacing Tool, you can quickly convert your DDS display file source members so that the user interface of your iSeries programs can run in a browser. When you convert your DDS display files, JSP files and Java beans are generated for you that substitute for the DDS code and make Web access possible. 

In the WebFacing Project wizard, you can select one or more DDS source members to convert, and select a Web look and feel from one of several predefined styles, or you can design your own Web style for use with your applications. The tool creates three JSP and XML files for each record format. The XML files hold the data for the record format, or control its appearance or other characteristics, and the JSP handles displaying the Web version of the screen, prompting for data, and handling input errors. The wizard generates an application home page to launch the Web-enabled version of your program. 

When you invoke a converted application from the browser, the WebFacing server on the iSeries server starts the server program. The server intercepts all calls to READ, WRITE, and EXFMT operations to DSPFs, so that in many cases your program (*PGM) can run without modifications, and without even detecting that it is being accessed using WebFacing. You might need to make coding changes if your application uses DDS keywords that are not supported by WebFacing, or if you want to modify the DDS screens so that the conversion to Web format produces a more attractive or consistent result. 

Note: For more information on WebSphere Development Studio Client and the IBM WebFacing Tool, see: http://ibm.com/software/awdtools/wdt400.
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